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centimeter (cm)
millimeter (mm)
meter (m)
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0.3937
0.03937
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0.6214
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Temperature in degrees Celsius (°C) may be converted to degrees Fahrenheit (°F) as follows:
°F = (1.8 × °C) + 32.

Monitoring Stream Temperatures—A Guide for
Non-Specialists
By Michael P. Heck1, Luke D. Schultz1, David Hockman-Wert1, Eric C. Dinger2, and Jason B. Dunham1

Executive Summary
Water temperature influences most physical and
biological processes in streams, and along with streamflows
is a major driver of ecosystem processes. Collecting data
to measure water temperature is therefore imperative,
and relatively straightforward. Several protocols exist for
collecting stream temperature data, but these are frequently
directed towards specialists. This document was developed
to address the need for a protocol intended for non-specialists
(non-aquatic) staff. It provides specific step-by-step
procedures on (1) how to launch data loggers, (2) check the
factory calibration of data loggers prior to field use, (3) how
to install data loggers in streams for year-round monitoring,
(4) how to download and retrieve data loggers from the field,
and (5) how to input project data into organizational databases.

Section 1. Getting Started—Why,
What, Where, When?
Is This Protocol for You?
Measuring stream temperature seems like a simple task,
but in our experience the details matter. Accordingly, several
protocols are available for measuring stream temperatures
that provide guidelines to help avoid common pitfalls,
including Dunham and others (2005), Isaak and Horan (2011),
Sowder and Steel (2013), U.S. Environmental Protection
Agency (2014), and Mauger and others (2015). Although
thorough, these previous protocols lack the clear guidance for
implementation for non-specialists. Our objective in this report
is to provide a simplified distillation of this advice for nonspecialists who may not have experience in monitoring stream
temperature, as well as providing standardized techniques
1
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and basic reporting. After reading through this protocol,
non-specialists with an interest in monitoring streams and
water quality will have the capability to effectively install
stream temperature data loggers to remotely record water
temperatures.

Why Monitor Water Temperature?
In streams, temperature represents the collective influence
of many factors that influence heat exchanges (Caissie,
2006), including heat gains from solar radiation, inflows of
groundwater or tributaries, and losses of heat from evaporation
or radiation to the atmosphere. Changes in streamflows,
stream shading, and other factors can significantly influence
stream temperatures. Increasingly, changing precipitation
patterns, decreasing snow cover and glaciers, and warming air
temperatures, among other factors, have led to concerns about
warming temperatures in streams (Isaak, Young, and others,
2016). Collectively, temperatures in streams reflect all of these
influences.
Temperature also is a central force behind just about
every biological process that takes place within stream
ecosystems (Magnuson and others, 1979), ranging from the
speed of chemical reactions to ecosystem productivity. Across
the United States, altered stream temperatures are a leading
source of water quality impairment, leading to loss of cold
water for species like Pacific salmon (Oncorhynchus spp.) and
steelhead (Oncorhynchus mykiss; Poole and others, 2001) and
native trout from the west to east coast (Shepard and others,
2016). In short, simply measuring stream temperature can
help us identify locations were restoration actions are needed,
provide us insight about how and why temperatures change
over time or vary in different locations, and help us anticipate
the consequences of these changes for water quality and
species distributions.
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Identifying the Key Questions about
Water Temperature
The most important step in designing a temperature
monitoring effort is to clearly identify the questions that
information from monitoring will answer (Nichols and
Williams, 2006). Common research questions regarding water
temperature include the following:
• How are temperatures in streams changing over time?
This could be related to an interest in daily fluctuations
in temperature, the seasonality of temperature or
thermal regimes, or changes across years or longer
periods of time—up to 30 years or longer in the case of
tracking climate-related changes.
• How do temperatures relate to potential causes of
heating or cooling? This could be related to the
importance of changes to shading of streams from
solar radiation, influences of heat exchanges with
groundwater, lakes, or runoff from glaciers and
snowfields, or an interest in how stream temperatures
track air temperatures.
• How do stream biota respond to temperature? This
could involve relating temperature to the presence,
abundance, or growth of species. Summaries of
temperature such as magnitude, variability, frequency,
duration, and timing could drive biotic processes.
The following sections provide guidance on how to frame
specific questions of interest for any monitoring effort.
Status.—The simplest question that can be asked about
temperature is “what is it?” This relates to the status of
temperature in a location and time sampled within a given
stream. As with many aspects of temperature, status can have
many meanings.
Because temperature is a continuous phenomenon, status
can refer to many characteristics. Variation in temperature
over time can be framed in terms of the magnitude, frequency,
duration, and timing of events (Arismendi and others, 2013a).
• Magnitude simply refers to how warm or cold
temperatures are. Understanding magnitude can
be important for addressing questions about water
quality, for example, where water-quality criteria are
often specified in terms of magnitudes (Falke and
others, 2016).
• Variability refers to temporal fluctuations in
temperature across a given time period. Although
stream fishes have adapted to withstand temperatures
fluctuating on a daily basis, the magnitude of that
fluctuation must remain within their range of biological
tolerances.
• Frequency refers to how many times a given thermal
condition is observed. For example, there may be
an interest in how many times water temperatures

exceeded thresholds that might cause biological stress
for given fish species or other aquatic organisms.
• Duration refers to how long a given thermal condition
persists. For example, studies of cold-adapted stream
fish (such as trout) shows that thermal tolerance is a
function of temperature (magnitude) and its persistence
(duration, expressed as the number of days that
temperatures exceed a critical threshold; Wehrly and
others, 2007).
• Timing of temperatures also is important because it
may influence the onset of different portions of the life
cycle of aquatic organisms (for example, spawning,
hatching, migration) or seasonality of factors with
major ecosystem consequences (such as onset of algal
blooms). Biologists often apply the term phenology
to the timing of biological events, such as hatching,
flowering, or many other types of responses, and there
are well established broad phenology networks to track
these events in response to changes in weather and
climate (USA National Phenology Network accessed at
https://usanpn.org/).
Collectively, variation in temperature across seasons
within a year, and among years, can be defined as a thermal
regime, which can be defined in terms of magnitude,
variability, frequency, duration, and timing of temperatures
(Arismendi and others, 2013a; Maheu and others, 2015;
table 1).
For practical purposes, the many ways in which status
can be described indicate that it is critical to be clear on what
aspects of thermal regimes are of most interest. Furthermore,
by embracing a regime-based view of temperature, one can
gain a tremendous range of useful insights (Arismendi and
others, 2013a), just as can be done for air temperatures. For
example, for the purpose of water-quality criteria, thermal
regimes are often considered in the context of only a single
weekly summary of maximum temperatures (McCullough,
2010). The other 358 days of a typical year also have value
in describing stream temperature status; one should consider
the costs and benefits of seasonal compared to year-round
sampling in this context. Few terrestrial ecologists would
consider data from a single week sufficient in describing a
thermal regime.
Trends.—Changes in status over time are often
referred to as trends. A common meaning of trend refers to
a progressive change over time, such as a simple pattern of
warming or cooling that may happen in a stream. Other more
complex patterns of change are possible, such as temperature
cycles linked to climate. Trends can be considered on any time
scale. Variation among hours within a day may be of interest
to understand short-term exposures of species to temperature
(McCullough, 2010). Seasonal warming and cooling (variation
among days within a season) is another common response of
interest. Annual trends in temperature can provide important
clues about responses to short-term events such as wildfires
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Table 1. List of examples of how to describe elements of a thermal regime, including magnitude,
variability, frequency, duration, and timing of temperatures.
[Modified from Benjamin and others (2016). Descriptor: The values in the table below (16, 18, and 20 °C) are common
thresholds for mean or maximum temperatures associated with tolerances of coldwater species (cooler values are applied to
some species or sensitive life stages [McCullough, 2010]). CTD, Cumulative Temperature Distribution is the date when each
site reached the 50th or 75th percentile of total degree days. Abbreviations: n, number (quantity of); °C, degrees Celsius;
>, greater than; %, percent]

Category

Descriptor

Definition

Magnitude (°C) Maximum
MWMT
MWAT
Degree days

Warmest temperature (typically of the year)
Maximum Weekly Maximum Temperature1
Maximum Weekly Average Temperature2
Accumulation of temperatures over time3

Variability (°C)

Mean range
Max range
Mean variance
Max variance

Difference between the highest and lowest daily mean
Difference between the highest and lowest maximum
A statistical measure of deviations among daily means
A statistical measure of deviations among daily maximums

Frequency (n)

Days > 16 °C
Days > 18 °C
Days > 20 °C

Number of days in the record that exceeded 16 °C
Number of days in the record that exceeded 18 °C
Number of days in the record that exceeded 20 °C

Duration (n)

Consec. days > 16 °C
Consec. days > 18 °C
Consec. days > 20 °C

Consecutive number of days in the record that exceeded 16 °C
Consecutive number of days in the record that exceeded 18 °C
Consecutive number of days in the record that exceeded 20 °C

Timing

CTD 50%
CTD 75%

Date of attaining 50% of the degree days in a given time frame4
Same as above, but for 75% of the distribution

Highest 7-day average of maximum daily temperatures in any season or year.

1

Highest 7-day average of average daily temperatures in any season or year.

2

Can be calculated by adding up average temperature for each day greater than zero degrees.

3

Summing degree days provides a tally of cumulative temperatures. Fifty percent is the point at which one-half of the total
heat has accumulated within a time frame (for example, within a year).
4

(Dunham and others, 2007; Heck, 2007) or longer-term
changes in climate (Isaak, Young, and others, 2016). As of this
writing, however, there are surprisingly few streams that have
been monitored for long-enough times (>10 years) to detect
reliable trends in the face of regionally changing climates
(Isaak and others, 2012; Arismendi and others, 2014; Luce and
others, 2014).
Spatial variation.—In recent years, a host of new spatial
statistical models have emerged that provide powerful new
capabilities for modeling patterns of temperature in whole
stream networks (Falke and others, 2013; Ver Hoef and others,
2014; Isaak and others, 2014; McNyset and others, 2015).
In practical terms, this means that it is possible to efficiently
make connections among locations sampled for stream
temperatures to provide a robust and continuous model-based
prediction of stream temperatures. The more points that are
sampled and how they represent variation in a stream network
result in more accurate and precise predictions at non-sampled
locations (Som and others, 2014). For example, based on
existing data, maps of stream temperatures derived from these
new models have been produced for much of the Northeastern
(DeWeber and Wagner, 2015) and Western United States

(Isaak, Wenger, and others, 2016), and have been used to
understand the distributions of temperature-sensitive species in
streams.
Additionally, stream temperatures can vary at extremely
fine spatial scales, sometimes with biologically significant
influences at scales of 1 m or less in the case of coldwater
thermal refuges (Torgersen and others, 2012). In short, one can
think of spatial variation in terms of the extent of the system
of interest and the resolution, or grain, at which information
is sought (Peterson and Dunham, 2010). Examples of extent
include questions about a watershed or stream network, or
perhaps questions within the boundaries of a given jurisdiction
(for example, a National Park or National Forest, State, or
other category of land ownership), and not tied to a specific
watershed. Within a given spatial extent, one can monitor
temperature at a given resolution (for example, samples every
1 km, every 100 m, and so on) to produce a representation
of how stream temperatures change through space (Fullerton
and others, 2015). The same analogy regarding scale here also
applies to time, which we discussed previously in section,
“Trends” (Steel and Lange, 2007; Peterson and Dunham, 2010).
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Factors influencing temperature.—In our coverage
of questions related to status, trends, and spatial variation,
we have already indicated some examples of questions tied
to understanding factors that influence stream temperature.
Ideally, one would quantify each component of the heat budget
of a stream and be able to use the basic laws of physics to
understand stream temperature. If there is an interest in factors
that influence stream temperature, it is important to consider
how streams heat in the context of a heat budget (Caissie,
2006), the linkages between these factors and natural or
human influences on temperature (Poole and Berman, 2001),
and what kinds of information are available that could serve
as useful indicators of these influences (for example, geology,
landform, climate, or vegetation; Wigington and others,
2012). Boyd and Kasper (2003) provide a useful, detailed
review of specific factors that influence heating of streams,
including factors influencing shade (for example, topographic
and streamside vegetation), heat transfers from belowsurface waters or mixing with tributaries, air temperatures,
evaporation, and streamflows.
In practice, complete accounting for the heat budget of
streams is seldom possible (Caissie, 2006). An alternative
approach to understanding factors that influence stream
temperature is through structured experimental manipulations
(Johnson and Jones, 2000; Groom and others, 2011), but these
can be expensive and difficult to implement, particularly
in areas where strong land- and water-use restrictions are
in effect. It is also difficult to conduct these experiments at
scales that are relevant to management concerns about stream
temperature (Fausch and others, 2002). Consequently, much of
our understanding of factors that influence stream temperature
relies on observational and correlational approaches (Caissie,
2006). For example, Isaak, Ver Hoef, and others (2016)
and Falke and others (2015) used spatial statistical models
to explore linkages between recent wildfires and spatial
variability of temperatures in stream networks.
Examples of factors that are commonly studied in relation
to changes in stream temperature include the following (see
Caissie [2006] for further detail):
• Changes in stream-side vegetation or shading. Trees,
shrubs, and other vegetation along the banks of
streams, and in some cases (such as very tall trees) in
upland areas, can intercept sunlight and prevent solar
radiation from reaching water in the stream channel.
Changes in vegetation occur seasonally (such as loss of
leaves in fall or leaf-out in spring) and annually (such
as forest growth, tree mortality, or changes in the types
of vegetation) in response to many different natural
and human influences. Shading is more likely to have
an effect on smaller streams.

• Changes in snow and ice cover, rainfall, and
streamflows. Melting snow and ice can lead to
substantial cooling of streams, and in combination
with rainfall contribute to greater streamflows. Larger
streams take more energy to heat. Understanding
sources of water, and how they are delivered over time
(for example, seasonal patterns of rain, snow, or ice
melt), in combination with how water moves through
the landscape into streams (for example, storage in
aquifers), can be important to understanding heating of
streams.
• Changes in the shape of the stream channel. The
complexity of stream channels, particularly in cases
of complex floodplains or wetlands, can result in
increased complexity of stream temperatures. This
can provide species that can move an opportunity to
take advantage of cold or warm spots in these places
to better meet their thermal requirements to complete
their life cycles. Localized inputs of groundwater or
inputs of solar energy (for example, from lakes or
ponds) are common examples of factors influencing
temperatures in these settings.
• Changes in below-surface waters. Changes in
availability or temperature of groundwater or how
water moves between the surface and sub-surface
within streams (through changes in shape of the stream
channel) can affect stream temperatures (that is,
relatively constant temperatures of spring-dominated
streams compared to streams dominated by runoff and
shallow groundwater storage).
• Influences of lakes or reservoirs. Water at the surface
of lakes and reservoirs spends more time in the sun and
can contribute heat to streams the surface water flows
into. If water is released from the bottom of a deep
reservoir into a stream, however, temperatures may be
cooled in warmer seasons of the year. Many reservoirs
are seasonally stratified into a warm top layer and cold
bottom layer in summer.
• Climate change. All influences on stream temperature
previously listed are directly or indirectly related to
the known and potential influences of climate change.
For example, a recent drought in the Western United
States led to losses of vegetation (from wildfire), low
streamflows, and increased water temperatures in a
large stream network (Schultz and others, 2017).
In practice, at least some of the factors listed here are
likely to play into questions about stream temperature to be
addressed through monitoring.
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Implications for biota.—Water temperature and
streamflow are considered to be the two most influential
variables that control stream biota and ecosystems (Magnuson
and others, 1979; Poff, 1997). In practice, stream temperatures
and flows often fluctuate together, with interactive effects
on biota (Arismendi and others, 2013b; Kovach and others,
2015). Accordingly, many questions about stream temperature
are focused on its effects on biota. To protect temperaturesensitive species, many states have identified biological
temperature criteria for Clean Water Act regulation (see Todd
and others [2008]) or developed methods to integrate spatial
models of stream temperature with biological criteria to
diagnose thermal impairment of streams (Falke and others,
2016). In short, when considering questions about biota,
consider which species are in question (fish, amphibians,
macroinvertebrates, and so on), and how they are hypothesized
to respond to temperature (survival, growth, and phenology).
There are an extensive amount of examples of studies relating
individual species to different measures of stream temperature;
we provide a few examples here to illustrate a range of
possibilities (table 2).
It is not possible here to cover all considerations involved
in addressing questions about biota (or ecosystem effects of
stream temperature), except to emphasize that these questions
are best served by engaging individuals with specialized
expertise from the start of a monitoring effort.

Sampling Design
After monitoring questions are identified, the next step
is to consider a sampling design. In short, a sampling design
considers both the population of interest or sampling frame
and how it is sampled. The population of interest consists
of all of the possible observations within a defined frame
of inference, for example, all of the possible locations that
could be instrumented within a given water body. It is usually
impossible or impractical to survey everything; a subset or
sample of the population is often drawn to make an inference
about the population as a whole. The manner in which a
sample is drawn influences the bias and precision of the
inferences about a population—how well a sample represents
the population. Bias is the degree to which a sample truly
represents the population, and precision refers to how strongly
inferences about a population are resolved. A robust sampling
design should consider the need to control both bias and
precision.
A full treatment of sampling design is outside of the
purview of this protocol, and decisions and intricacies of
sample design should not sway or deter an individual from
collecting temperature data. The background presented here
is intended to provide a reference for those with an interest in
the basics of sample design considerations. Given the scarcity
of long-term, year-round temperature data, any information

Table 2. Categories of temperature descriptors and selected examples of associated biotic responses of stream biota to them.
[Category: n, number; °C, degrees Celsius]

Category
Magnitude (°C)

Descriptor

Examples of biotic responses

Maximum and minimum
temperatures

Short-duration or acute physiological stress or death if temperatures are too warm (for example,
trout and salmon; McCullough, 2010) or too cold (for example, smallmouth bass; Horning
and Pearson, 1973).

Degree days

Indicator of development time or growth potential in fish (Neuheimer and Taggart, 2007)
and stream insects (Everall and others, 2015). Degree days includes both a description of
magnitude and duration of exposure.

Temporal variance

Increased variability in temperatures may lead to greater likelihood of physiological stress in a
location (Kammerer and Heppell, 2013).

Spatial variation

Species need to invest more effort in finding suitable temperatures among locations within a
network of streams when spatial variation in thermal suitability increases (Torgersen and
others, 2012).

Frequency (n)

Days

Number of days in the record that exceed critical thresholds explained the distribution of
different species of native and nonnative trout (Benjamin and others, 2016).

Timing

Date

Species may be adapted to the specific timing of temperatures in systems to successfully
complete their life cycles (Vannote and Sweeney, 1980).

Variability (°C)
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gained will be useful for many purposes. At a minimum, we
recommend documenting the decision process for (1) where
and when samples were collected, (2) the frequency of
sampling, (3) total number of samples, and (4) method of
sample allocation. We discuss each of these points briefly here
to help the non-specialist enter into discussions with sampling
experts.
Where and when to sample.—The answer to this
question depends on the monitoring objectives. If the
objective is to understand the seasonal fluctuations at a
previously monitored site, then the answer is simple: deploy
the data logger at the previously monitored site for a full-year
deployment to represent all seasons. Multi-year deployments
also may be of interest, particularly if climate-related
associations are relevant (where 30 years or more of data are
most desirable). If the monitoring objective is to quantify
the distribution of thermal regimes in a given area, then the
placement requires more thought. Examples include patterns
of temperature among possible locations to sample within a
given land ownership, range of a species of concern, water
body (lake or stream network), water body type (perennial or
intermittent), or any other possible frame of inference.
Frequency of sampling.—Frequency of sampling
refers to how often temperatures are recorded. Given the high
memory capacity of temperature data loggers, an interval of at
least 1 hour or less is a good rule of thumb. Longer intervals
between measurements run the risk of missing important high
or low temperatures within a day (Dunham and others, 2005).
Sample size.—Desirable sample sizes, or number
of locations sampled, depend on the size or extent of the
sampling frame and specific objectives of the sampling effort,
and the degree of variability in temperatures among sites.
Temperatures can vary over very small (<1 m) extents in
streams and lakes in association with variable groundwater
inputs, lack of mixing between cold and warm layers, and
other factors. Mobile animals are often highly capable
of exploiting such fine-scale variation in temperature
and this may be of interest (Beever and others, 2017).
Alternatively, temperatures also vary over larger extents; a
broader understanding of spatial and temporal variability in
temperature may be of greater interest. Examples include
associations between temperature and the topography of
landscapes, vegetative cover, or availability of temperature in
space or time for migrating species. In any case, the number of
samples to represent this variability may be large (>30), even
for smaller sampling frames. Note that any temperature data
collection can be valuable, even if available resources limit
sample sizes.
Sample allocation.—Sample allocation refers to
how samples are distributed in space or time. The simplest
approach is to distribute samples subjectively, based on

ease of access, safety concerns, or other concerns not related
to statistical representation. However, subjective samples
cannot be thought to faithfully represent a larger population
of possible samples within a population or sampling frame.
The other end of the continuum is a purely random or equal
probability sample. This means that each possible location
in space or time has an equal chance of being sampled.
Probabilistic samples such as this provide a much more
reliable representation of the population or sampling frame.
There are many other examples of probabilistic designs (Som
and others, 2014).

A Few Preliminary Notes
Because this guide is written for non-specialists, we
assume users are working with limited resources and hoping to
accomplish useful temperature monitoring to address a limited
scope of objectives or questions about stream temperature.
Virtually any collection of high-quality stream temperature
data can be tremendously useful. For example, crowdsourcing
of temperature data from a variety of local monitoring
efforts has long been the source of valuable temperature
information on a national (Eaton and others, 1995) and
regional basis (Dunham and others, 2003; DeWeber and others,
2015; Chandler and others, 2016). Thus, even collection
of temperature data from a single location to address local
objectives has potential to contribute significant information
for regional to national applications.
Before getting into the details of how to monitor stream
temperature, a few preliminary considerations should be taken
into account: (1) the identification of relevant safety protocols,
(2) the selection of temperature data loggers and data storage
systems, and (3) the planning for the timing of field operations.
These three primary considerations should be addressed before
moving forward with the Standard Operating Procedures
(SOP).
A variety of safety considerations are relevant to working
in and around streams, including driving motor vehicles on
backcountry roads, hiking to remote field sites, wading on
slippery streambeds and in swift water currents, and using hand
tools to install temperature data loggers. Even seemingly safe
situations can become life-threatening if proper precautions
are not taken. Wearing a U.S. Coast Guard approved personal
flotation device is recommended when working in and around
bodies of water. Beyond that, we encourage all users to consult
safety officers within their local units or other experienced
personnel for specific guidance on this topic.
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In regard to selection of temperature data loggers
a variety of options are available (Dunham and others,
2005; U.S. Environmental Protection Agency, 2014). For
consistency, we focus on a single brand of instruments
(table 3) and their associated hardware and software (table 4).
Further, we focus on a single data storage software package
(see SOP 6—Importing and Managing Data) so we can be
specific on protocols to use. That said, the protocols described
here can be adapted to a wide variety of temperature data
loggers and software packages. The basic concepts of
launching, checking the calibration, installing in a stream,
downloading, and exporting of data are all necessary
components of any monitoring project.
The timing of field operations will have a profound
influence on data quality as well as the safety of the field
personnel. Becoming familiar with a hydrologic regime

prior to stepping foot in a stream is paramount to a safe and
successful monitoring project. Installations should take place
at base flow to ensure loggers can be placed safely in the
thalweg. The thalweg is defined as the deepest part of the
channel at any given cross section. Installing a data logger
during high flows is not only dangerous to field personnel but
can lead to failure to place the data logger in a deep enough
location to stay wet as streamflows recede (unless the entire
channel dries). Additionally, if interested in year-round
monitoring, additional considerations as to placement location
would be required given the higher probability of loss or
damage to equipment and thereby data. A review of historical
data from U.S. Geological Survey streamgages (https://
waterdata.usgs.gov/usa/nwis/rt) can be useful for anticipating
when suitable low flows are likely to occur on a particular
stream or within a given watershed.

Table 3. Onset data loggers commonly used in stream temperature monitoring programs.
[Accuracy: Accuracy for commonly observed stream temperatures (0–35 °C). Unit cost: $, U.S. dollars. Abbreviations: cm, centimeter; m, meter ; °C, degrees
Celsius]

Accuracy Resolution
(°C)
(at 25 °C)

Data logger
Onset HOBO® Water Temperature Pro v2
U22-001
Onset HOBO® 64K Pendant® Temperature
UA-001-64
Onset HOBO® TidbiT® v2
UTBI-001

Battery
Replaceable
Memory
Waterproof
life
battery? (measurements)
(m)
(years)

Dimensions
(cm)

Unit
cost

±0.21

0.02 °C

6

No

42,000

to 120 m

3.0 × 11.4

±0.53

0.14 °C

1

Yes

52,000

to 30 m

5.8 × 3.3 × 2.3

±0.21

0.02 °C

5

No

42,000

to 305 m

3.0 × 4.1 × 1.7 $133

$129
$59

Table 4. Software and hardware components necessary to use Onset® data loggers.
[Unit cost: $, U.S. dollars]

Product

Purpose

Unit cost

Onset HOBOware Pro Software
BHW-PRO-DLD

Software used for all HOBO data loggers. Use software to launch and read out data
loggers, plot data, and export for further analysis.

Onset Optic USB Base Station
BASE-U-4

Hardware interface between Onset® data loggers and HOBOware® Pro. Use the base station
to launch the loggers on a PC/Mac. Couplers are included for compatibility with Onset
U22, Pendant®, and TidbiT® data loggers.

$124

Onset HOBO® Waterproof Shuttle
U-DTW-1

Use the waterproof shuttle to download and re-launch the loggers in the field. Connect the
waterproof shuttle to a PC/Mac to offload that data into HOBOware® Pro. Waterproof
to 20 meters. Couplers are included for compatibility with Onset U22, Pendant®, and
TidbiT® loggers.

$249

®

®

$99
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Section 2. Standard Operating Procedures
Introduction
Figure 1 shows the workflow of the standard operating procedures. Please note that these procedures refer primarily to
Onset data loggers. These are commonly used products with which we are most familiar, but procedures for other products
would be similar.

Launching Data Loggers
How to program data loggers to record data at a specific interval using proprietary software

Calibration Check of Data Loggers
How determine if data loggers are measuring temperature to the manufacturer's specifications

Installing Data Loggers in a Stream
How to anchor a data logger in a stream channel for year-round data collection

Downloading Data Loggers
How to download data and re-launch a data logger in the field using a waterproof shuttle

Offloading and Exporting Data in HOBOware Pro
How to offload data from a waterproof shuttle and export those data from HOBOware Pro

Importing and Managing Data
How to import data into a database, such as Aquarius Time-Series software
Figure 1. Diagram showing standard operating procedure workflow.
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Standard Operating Procedure (SOP) 1—Launching Data Loggers
Overview
This SOP describes how to program temperature data loggers prior to a calibration check or installation in the field. This
SOP covers setting a logging interval, programming a delayed launch, and which metrics to record.

Supplies
• Computer with HOBOware Pro software installed
• Onset Optic USB Base Station
• Onset data loggers (U22, Pendant, or TidbiT)
• COUPLER2-A (for Pendant), COUPLER2-C (for U22), or COUPLER2-D (for TidbiT)

Procedure—Set Up HOBOware Pro Software
1.

Install HOBOware Pro.

2.

Open HOBOware Pro and continue through the
HOBOware Setup Assistant.
a.

Click Start (fig. 1.1)

b.

Click USB devices only > Next (fig. 1.2)

c.

Select SI from Unit System drop-down, then click
Next (fig. 1.3)

d.

Leave all Data Assistants boxes checked, then click
Next (fig. 1.4)

Figure 1.3. Screen capture showing HOBOware Setup Assistant
Unit System dialog box.

Figure 1.1. Screen capture showing HOBOware Pro initial Setup
Assistant dialog box.

Figure 1.2. Screen capture showing HOBOware Setup Assistant
Device Types selection dialog box.

Figure 1.4. Screen capture showing HOBOware Setup Assistant
Data Assistants selection dialog box.

®
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e.

Select whether or not to send metrics to Onset
Computer Corporation, then click Next (fig. 1.5).

b.

In the navigation pane, click Display, then click
Series to access options (fig. 1.8).

f.

Click Done (fig. 1.6)

c.

Check the box next to Show the option to log
battery, then click OK.

Select the option to log battery voltage.

3.

a.

On main screen, click File > Preferences (fig. 1.7).

Figure 1.5. Screen capture showing HOBOware Setup Assistant
Help improve HOBOware? dialog box.

4.

Complete steps 1–3 only once as these settings will
remain until an update is installed. After updates are
installed, repeat steps 1–3.

Figure 1.6. Screen capture showing HOBOware Setup Assistant
Congratulations… dialog box.

Figure 1.7. Screen capture showing HOBOware Pro Preferences… option under the File menu.
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Figure 1.8. Screen capture showing HOBOware Pro Preferences dialog box, Display tab and Series preferences.

Procedure—Launch a Data Logger
1.

b.

Connect the Onset Optic USB Base Station to the
computer using the USB cable and the temperature data
logger to the base station using the appropriate coupler
(fig. 1.9).

Wait a few seconds for the data logger to be detected
by the computer. If no data logger is detected, check
all connections, especially the data logger/coupler
connection, and make sure the data logger is fully
inserted.

c.

Data loggers can occasionally have a tight fit with
the coupler. A data logger is fully inserted when you
hear an audible “click.”

For older versions of U22 data loggers, make sure
the arrow printed on the outside of the data logger is
lined up with the arrow on the coupler.

d.

For newer versions of U22 data loggers, a ridge on
the optic end should match the groove in the coupler,
ensuring good alignment.

a.

Figure 1.9. Photograph showing Onset couplers for Onset data loggers. From
left to right: Coupler2-A for Pendant data loggers, Coupler2-C for U22 data
loggers, and Coupler2-D for TidbiT data loggers.
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2.

On the main screen, click Device > Launch… to open
the Launch Logger dialog box (fig. 1.10).

4.

Record the unique data logger serial number from the
Launch Logger dialog box (fig. 1.12).

3.

Create a Launch Worksheet to record basic metrics from
the launch process (fig. 1.11). Only use the Launch
Worksheet for field installations (SOP 3—Installing Data
Loggers in a Stream). There is no need to record basic
metrics from a calibration check (SOP 2—Calibration
Check of Data Loggers).

5.

In the Sensors group box, make sure both Temperature
and Logger’s Battery Voltage boxes are checked
(fig. 1.13).

Figure 1.10. Screen capture showing HOBOware Pro Launch… option under the Device menu.

Serial#

LaunchDate

LaunchTime

LaunchVoltage

Interval

10950791

6/13/2016

8:00am

3.48

1 hour

Figure 1.11. Example of a Launch Worksheet.
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Figure 1.12. Screen capture showing HOBOware Pro Launch Logger dialog box.
The red oval highlights the unique data logger serial number.

Figure 1.13. Screen capture showing HOBOware Pro Launch Logger dialog box.
The red oval highlights Temperature and Logger’s Battery Voltage check boxes.
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6.

In the Deployment group box, select desired logging
interval from the Logging Interval drop-down list
(fig. 1.14).
a.

7.

Logging interval recommendations are: 10 seconds
for calibration checks (SOP 2—Calibration Check
of Data Loggers) and 1 hour for field installations
(SOP 3—Installing Data Loggers in a Stream). A
1-hour logging interval has been shown to have
a low probability of missing the daily maximum
temperature by more than 1°C (Dunham and others,
2005, fig. 5).

b.
8.

Click Delayed Start to launch the data logger.

9.

Record the battery voltage at the time of launch on the
Launch Worksheet. Voltage is important to note because
installing a data logger with a low battery could result in
data loss.

In the Deployment group box, select a delayed start in
Start Logging: On Date/Time and set to mm/dd/yy at
hh:mm:ss. This is the time when the data loggers will
activate and begin recording temperatures.
a.

A delayed start will reduce, but not eliminate, the
amount of measurements collected before the data
logger is installed in a stream. It is acceptable for
data loggers to begin recording several days or
weeks before their field installation as long as data
recorded prior to installation is flagged as “preinstall” at the conclusion of monitoring.

Record the date/time of the delayed start on the
Launch Worksheet (fig. 1.11).

10.

a.

On main screen, click Device > Status (fig. 1.15).

b.

The battery voltage is shown in the Current
Readings group box of the Status dialog box
(fig. 1.16).

c.

Onset U22 data logger battery voltage should be
greater than 3.3 volts (V); and Onset TidbiT and
Onset Pendant data loggers battery voltage should be
greater than 2.7 V. Send data loggers with voltages
below these levels back to the manufacturer.

Disconnect the data logger from the base station. It is
now ready for its calibration check (SOP 2—Calibration
Check of Data Loggers) or installation in the field
(SOP 3—Installing Data Loggers in a Stream).

Figure 1.14. Screen capture showing HOBOware Pro Launch Logger dialog box. The
red oval highlights the Logging Interval drop-down list.
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Figure 1.15. Screen capture showing HOBOware Pro Status… option under the Device menu.

Figure 1.16. Screen capture showing HOBOware Pro Status dialog box.
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Standard Operating Procedure (SOP) 2—Calibration Check of Data Loggers
Overview
This SOP describes how to determine if data loggers are measuring temperature to the manufacturer’s specifications.
Thermometers and data loggers calibrated to National Institute of Standards and Technology (NIST) standards are available
as a reference during calibration checks. A calibration check should be performed before and after each field installation.
A calibration check consists of data loggers recording for 30 minutes in a warm bath, 30 minutes in a cool-down bath, and
30 minutes in a cold bath. This process takes approximately 2 days to complete.

Supplies
• Three coolers (large enough to submerge all data loggers with lots of extra room)
• Crushed ice
• Onset data loggers (U22, Pendant, or TidbiT)
• One NIST-calibrated Onset data logger (use same model as data logger being calibrated: U22, Pendant, or TidbiT)
• 8-in. cable/zip ties (0.095 in. width)
• 10-oz lead fishing weights (one weight per five data loggers)
• Onset Optic USB Base Station
• COUPLER2-A (for Pendant), COUPLER2-C (for U22), or COUPLER2-D (for TidbiT)
• Computer with HOBOware Pro software installed

Procedure—Day 1
1.

2.

b.

Fill a cooler about 3/4 full with room temperature
water and place in a climate controlled room (stable air
temperature). This will be the warm bath.

Set a delayed start to a time the following day to
initiate the calibration check. Make sure there is
adequate time to set up the cold bath (see step 4).

c.

Create a Calibration Check Worksheet to record
basic metrics from the calibration process (fig. 2.1).

Launch data loggers, including the NIST-calibrated data
logger following procedures in SOP 1.

d.

Record the serial number and battery voltage at the
time of launch on Calibration Check Worksheet.

a.

Select a 10 second logging interval.

Serial#

CalibVoltage

CalibDate

CalibMeanWarmDiff CalibMeanCoolDiff

10768077

3.57

7/26/2016

0.068

0.011

10768078

3.54

7/26/2016

0.057

0.084

10768079

3.57

7/26/2016

0.019

0.000

10768080

3.57

7/26/2016

0.043

0.055

Figure 2.1. Example of a Calibration Check Worksheet.
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3.

Bundle five data loggers and one 10-oz lead fishing
weight together with an 8-in. cable/zip tie (fig. 2.2).

4.

Immerse launched and bundled data loggers in the warm
bath and let soak overnight with the cooler lid open
(fig. 2.3).

Procedure—Day 2
1.

Approximately 3 hours before the data loggers are
programmed to start recording, fill two coolers about 3/4
full with crushed ice and add cold water until ice is fully
immersed in water.
a.

2.

Following the delayed start time, begin mixing the water
in the warm bath by gently lifting one end of the cooler
about 4 in. off the ground.
a.

3.

Figure 2.2. Photograph showing five Onset U22 data loggers
attached to a 10-ounce lead weight with an 8-inch cable/zip
tie.

Figure 2.3. Photograph showing four clusters of five
Onset U22 data loggers soaking in a warm bath used for a
calibration check.

Close lids and place coolers in the same climate
controlled room (stable air temperature). These will
be the cool-down and cold baths.

Repeat this mixing/lifting about every 20 seconds for
30 minutes. The warm calibration check is complete.

Remove the bundled data loggers from the warm bath
and immerse them in the cool-down bath (one of the two
coolers with ice/water mixture) and close the lid.
a.

The cool-down bath is used to decrease the
temperature of the data loggers from room
temperature to about 0 °C.

b.

Leave the data loggers in the cool-down bath for
30 minutes.

4.

Remove the bundled data loggers from the cool-down
bath and immerse them in the cold bath.

5.

Mix the water in the cold bath by gently lifting one end
of the cooler about 4 in. off the ground.
a.

Repeat this mixing/lifting about every 20 seconds for
30 minutes. The cold calibration check is complete.

6.

Open HOBOware Pro software and download all the
available updates, if prompted (fig. 2.4)

7.

Connect the Onset Optic USB base station to
the computer using the USB cable and connect a
temperature data logger to the base station using the
appropriate coupler (see SOP 1—Launching Data
Loggers).

Figure 2.4. Screen capture showing HOBOware Pro Check for
Updates? dialog box.
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Readout data from the data logger.

8.

a.

On the HOBOware Pro main screen, click Device >
Readout… (fig. 2.5).

b.

When prompted to stop the data logger, click Stop
(fig. 2.6).

c.

Create or select a folder in which to store .hobo file,
then save the file (fig. 2.7).

d.

The Plot Setup dialog box will open (fig. 2.8). To
see a graph of the data, click Plot, otherwise click
Cancel.

Figure 2.5. Screen capture showing HOBOware Pro screen capture showing the Readout… option under the Device menu.

Figure 2.6. Screen capture showing HOBOware Pro Stop
Logger? dialog.
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Figure 2.7. Screen capture showing HOBOware Pro Save dialog box to determine the
location to save a .hobo file.

Figure 2.8. Screen capture showing
HOBOware Pro Plot Setup dialog box.
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9.

Disconnect the temperature data logger from the base
station. After readout, the data logger will be stopped
and will remain in that state until it is launched again.

b.

Browse to the folder where the .hobo files were
saved and select all the files, then click Continue
(fig. 2.10).

10.

Continue to readout data from all data loggers (repeat
step 7).

c.

11.

After reading out data from all data loggers, export the
.hobo files as .csv files.

In the Choose Export Folder dialog box, choose
folder where to save the .csv files, then click Export
(fig. 2.11).

d.

When the bulk file export is complete, click OK.

a.

On the HOBOware Pro main screen, click
Tools > Bulk File Export > Select Files to
Export… (fig. 2.9).

12.

Close HOBOware Pro.

13.

Open Microsoft Excel or other spreadsheet application
and create a blank worksheet.

Figure 2.9. Screen capture showing HOBOware Pro Select Files to Export… option under the Bulk File Export option, under the
Tools menu.

Standard Operating Procedure (SOP) 2—Calibration Check of Data Loggers   21

Figure 2.10. Screen capture showing HOBOware Pro Select Files to Export dialog box to select .hobo files to export as .csv files.

Figure 2.11. Screen capture showing HOBOware Pro Choose Export Folder dialog box to determine the location to export .csv
files.
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14.

Open an exported .csv file, select the Date Time and
Temp columns (fig. 2.12), then copy and paste them into
columns A-B of the blank worksheet.

15.

Continue opening .csv files and copying and pasting the
Date Time and Temp columns into C-D, E-F, G-H, and
so on (fig. 2.13). The header of the Temp column can be
shortened to the data logger serial number (S/N).

16.

Create a graph of data logger temperatures over time.
Make sure to include the NIST-calibrated data logger
temperatures (fig. 2.14).
a.

Identify a period during the warm bath of greater
than or equal to 15 minutes (90 consecutive records)

when data loggers are recording highly consistent
temperatures. It is not possible to quantify what
“highly consistent” temperatures are because the
purpose of the calibration check is to look for data
loggers that are dissimilar from one another and the
NIST data logger. That comparison needs to be made
when all data loggers are recording temperatures in a
highly consistent or similar way.
b.

Identify a period during the cold bath of greater
than or equal to 15 minutes (90 consecutive records)
when data loggers are recording highly consistent
temperatures.

Figure 2.12. Screen capture showing exported .csv file opened in Microsoft® Excel with the Date Time and Temp columns highlighted.
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Figure 2.13. Screen capture showing Microsoft® Excel with Date Time and Temp columns copied from five .csv files and pasted into
one worksheet. The Temp column headers were shortened to the data logger serial number (S/N).

Figure 2.14. Graph showing temperature over time for five Onset U22 data loggers. During
this calibration check, data loggers were placed in a warm bath before moving to a cooldown and then a cold bath. Periods of 15 minutes (90 consecutive records) with highly
consistent temperatures are highlighted by red ovals.
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17.

Calculate the mean temperature for each data logger
during that period of 90 consecutive records during the
warm calibration.

18.

Calculate the difference between the mean temperature
of the NIST calibrated data logger and mean temperature
of each individual data logger.
a.

Record that value under CalibMeanWarmDiff in the
Calibration Check Worksheet (fig. 2.1).

19.

Calculate the mean temperature for each data logger
during that period of 90 consecutive records during the
cold calibration.

20.

Calculate the difference between the mean temperature
of the NIST calibrated data logger and mean temperature
of each individual data logger.
a.

21.

Record that value under CalibMeanCoolDiff in the
Calibration Check Worksheet (fig. 2.1).

Diagnose data loggers with inaccurate measurements by
identifying data loggers with a CalibMeanWarmDiff or
a CalibMeanCoolDiff that is outside the manufacturer
specified tolerance.

a.

Accuracy for Onset U22 and TidbiT data loggers is
±0.21 °C.

b.

Accuracy for Onset Pendant data loggers is
±0.53 °C.

c.

Send inaccurate data loggers back to the
manufacturer.

Procedure—Post-Field Installation Calibration
Check
1.

Perform a calibration check after a data logger has been
collected following field installation to check for drift in
temperature measurements.
a.

2.

Drift of temperature measurements is when pre- and
post-field calibration checks are not equal.

Test the accuracy of a data logger following its field
installation by performing the same 2-day calibration
check as outlined here.
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Standard Operating Procedure (SOP) 3—Installing Data Loggers in a Stream
Overview
This SOP describes how to anchor a data logger in a stream channel for year-round data collection. This SOP also covers
which site characteristics to record to make retrieving the data logger easier.

Supplies
• Global Positioning System (GPS; pre-loaded with site coordinates in decimal degrees latitude/longitude or Universal
Transverse Mercator [UTM])
• Maps
• Stream Temperature Data Logger Installation Form (see example in appendix 1)
• Pencil
• Digital camera
• Digital thermometer
• Onset data loggers (U22, Pendant, or TidbiT)
• PVC solar shields (1 per data logger)
• 8-in. cable/zip ties (0.095 in. width; minimum two per Pendant)
• 11-in. cable/zip ties (0.18 in. width; minimum two per U22 or TidbiT)
• 36-in. cable/zip ties (0.35 in. width; three per site)
• UV resistant sand bags (two per site)
• 36-in. rebar (0.5 in. diameter; one per site)
• Rebar caps (one per piece of rebar)
• DUCKBILL Earth Anchors Model 40 (one per site)
• Driving rod for DUCKBILL Earth Anchors Model 40 (one per site)
• DUCKBILL Earth Anchors Model 68 (one per site)
• Driving rod for DUCKBILL Earth Anchors Model 68 (one per site)
• 5 lb sledge hammer
• Flagging (optional)
• Wire cutters
• Waders/wading boots or wet wading gear
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Procedure—Data Logger Installation
1.

2.

c.

Navigate to the site using a GPS unit and maps.
a.

Get as close as possible to the pre-loaded UTM or
latitude/longitude coordinates; it is rarely possible
to reach the exact location because of the inherent
accuracy of commercial GPS units.

b.

If coordinates are not within the stream channel (for
example, they are on the adjacent hillslope), take the
shortest distance to the stream.

c.

The coordinates are only a starting point. The actual
location for data logger placement will depend on
where adequate security, depth, and mixing are
found.

Choose an actual location for the anchor based on
adequate security, depth, and mixing (fig. 3.1).
a.

Security. Enables data logger to survive high flows
where debris and hydraulics can dislodge and
displace the data logger. A secure anchor location
might be behind a large object, such as a boulder or
large wood.

b.

Depth. Enables data logger to remain underwater
at base flows, when shallow habitats desiccate but
some water is still present in the channel. Anchoring
the data logger in or near the thalweg will ensure the
data logger remains wet until the stream no longer
holds water.

3.

Mixing. Enables data logger to collect accurate data.
Stagnant water is more susceptible to warming/
cooling, which may not be representative of
conditions in the stream. If possible, anchor the
data logger in a location with moving water. Avoid
selecting a location too close to a tributary junction
or seep as these locations may not be representative
either.

Choose an anchor method based on stream
characteristics. See table 3.1 for a comparison of anchor
methods.
a.

Cable/zip ties are the preferred method in streams
with abundant wood/roots adjacent to deep, mixed
water. For very large pieces of wood, it may be
necessary to join two or more 36-in. cable/zip ties
together end-to-end, as a daisy-chain (fig. 3.2).

b.

DUCKBILL Earth Anchor (fig. 3.3) is the preferred
method in streams without suitable wood and with
substrates ranging from silt to cobble, and good
for large, high-discharge streams. In general, use
the largest size DUCKBILL that can be driven into
the substrate. Using the sledge hammer and the
appropriate driving rod, drive the DUCKBILL as
deep as possible straight down into the substrate,
but leave at least 6 in. of cable protruding. After
reaching the desired depth, remove the driving rod
and pull on the cable with considerable pressure to
rotate and anchor the DUCKBILL (fig. 3.4).

Figure 3.1. Photographs showing temperature monitoring site looking downstream during low flow (A) and high
flow (B), and looking upstream during low flow (C) and high flow (D). Note the data loggers are attached to a
sandbag anchor at the base of the boulder. Photographs by Todd Allai, Bureau of Land Management.
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Table 3.1. Comparison of four anchor methods commonly used
to install data loggers in wadeable streams.
[Tradeoffs between the probability of an anchor surviving high flows
(Stability), the ease of finding the anchor at a later date (Retrieval), the
amount of in-channel disturbance necessary to remove the anchor following
monitoring (Footprint), and the amount of time and cost of equipment (Cost)
are compared. The more stars in a rating, the better the rating]

Anchor method

Security

Footprint

Retrieval

Cost

Cable ties
Sandbag
Rebar
Duckbill Earth Anchor

**
*
***
****

****
***
**
*

**
****
***
*

****
***
**
*

Figure 3.4. Photograph showing data logger attached
to a DUCKBILL anchor. Note the thin grey cable to the
left of the white PVC solar shield. The actual DUCKBILL
is buried in the sediment where the cable disappears
and is highlighted by a red oval. Photograph by Brianna
Sempert, U.S. Geological Survey.
Figure 3.2. Photograph showing data logger anchored to large
wood in stream with a 36-inch cable/zip tie.

Figure 3.3. Photograph showing DUCKBILL Earth Anchors
Model 88 (outer), Model 68 (middle), and Model 40 (inner).

c.

Rebar is the preferred method in streams without
suitable wood and with silt or sand substrates, and
good in streams with poor visibility, as rebar sticking
out of the water is easy to locate. Using the sledge
hammer, drive the rebar vertically into the substrate,
leaving a portion protruding from the water surface.
Use a rebar cap for safety and visibility (fig. 3.5).

d.

Sandbags are the preferred method in streams without
suitable wood, with bedrock or boulder substrates, or
when impact or footprint of the anchor is a concern.
Sandbags work best in smaller streams where high
flows do not occur. Double-up sandbags and fill 3/4
full with gravel/cobble. Filling with smaller substrate
will result in a heavier bag (fig. 3.6).
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4.

Insert the previously-launched data logger into the PVC
solar shield and thread two 8-in. or 11-in. cable/zip ties
through the solar shield and data logger. Secure solar
shield and data logger to anchor (fig. 3.7).
a.

If using a 36-in. cable/zip tie around wood, loop the
smaller cable/zip ties around the 36-in. cable/zip tie.

b.

If using a DUCKBILL anchor, attach the data logger
to the provided loop in the anchor cable.

c.

If using rebar, attach the data logger where the rebar
protrudes from the substrate. If there is concern
that the cable/zip tie will slip on the rebar, consider
attaching a wire clamp above the cable/zip ties to
prevent them from moving.

d.

If using sandbags, attach the data logger to the hole in
the sandbag where the ties are attached.

5.

Hang flagging on vegetation near the data logger. If
regulations discourage the use of flagging or theft is a
concern, do not hang flagging.

6.

Measure water temperature at the data logger location
using the digital thermometer.

7.

Take multiple photos of the data logger location. If
possible, a crew member should stand next to data logger
and point at it for scale/reference. Capture unique features
near data logger (such as large boulders or snags).

Procedure—Record Data on Stream Temperature
Data Logger Installation Form
1.

Site #: Enter unique site identifier.

2.

Crew: Enter names of personnel involved with
installation.

3.

Date: Enter date of installation.

4.

Time: Enter time of installation.

5.

Data Logger Serial #: Enter serial number; see the sevenor eight-digit number printed on the outside of the data
logger (figs. 3.8 and 3.9).

6.

Latitude/Longitude or UTM coordinates: Enter
coordinates of the actual location (obtained from GPS)
where the data logger is installed, not the pre-loaded
coordinates used to generally locate the installation site.

7.

Site Condition: Circle Wet or Dry depending on whether
there is water present at the site.

8.

Water Temperature: Enter temperature, measured with
digital thermometer, at time of installation.

Figure 3.5. Photograph showing data logger anchored to a
36-inch piece of rebar protruding vertically from the substrate,
highlighted by a red oval. Note the yellow rebar cap for safety
and visibility.

Figure 3.6. Photograph showing data logger anchored to a
sandbag at the base of a large boulder, highlighted by a red
oval. Photograph by Todd Allai, Bureau of Land Management.

Figure 3.7. Photograph showing Onset U22 data logger
inside a PVC solar shield and attached to a DUCKBILL anchor
cable with two 11-inch cable/zip ties.
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b.

Figure 3.8. Photograph showing serial number placement on an
Onset U22 data logger.

The sensor on Onset Pendant and TidbiT data
loggers is located in the center of the device.
Because these data loggers are so small and it is
difficult to determine where the sensor is relative
to the water surface, consider the entire data logger
when recording its condition.

10.

Bank: Looking downstream, circle the closest bank
(Right or Left) to the anchored data logger. If the data
logger is closest to the center of the stream channel,
circle “Middle.”

11.

Anchor: Circle the anchor method used: Sandbags,
Rebar, Cable/zip ties, or DUCKBILL.

12.

Flagging: Circle Yes or No, for whether or not flagging
was hung adjacent to data logger. Note flagging color in
margin.

13.

Quality: Circle Great, OK, or Poor, to subjectively
evaluate the overall quality of the data logger location
and anchor method in terms of survivability. This is in
reference to the probability the data logger remains in
the same location where initially installed and can be
located by personnel unfamiliar with the site.

14.

Camera ID: Enter a unique identifier of the camera used
to take the site photos, if more than one camera is being
used to photograph data logger installations.

15.

Photo #’s: Enter camera photograph file numbers of
every photograph taken at the site.

16.

Notes: Enter a description or sketch of the site so it can
be easily accessed and located by personnel unfamiliar
with the site. Take ample notes to describe exact location
of the data logger (for example, sandbag placed about
0.5 m off the right bank and about 1 m downstream of
overhanging mountain mahogany).

Figure 3.9. Photograph showing serial number placement on an
Onset Pendant data logger.

9.

Logger Condition: Circle the description that best
matches the data logger condition at time of installation.
Take note of where the sensor is located (fig. 3.10)
on the data logger and record whether the sensor is
completely submerged, submerged but close to the
water’s surface, exposed to air but close to the water’s
surface, or completely dry. Depending on the objective
of the study, it may be appropriate to install a data logger
close to the water’s surface or in a dry stream channel.
a.

The sensor on U22 data loggers is located at the
mounting hole end of the device (fig. 3.10).

Figure 3.10. Photograph showing Onset U22 data logger with the
sensor end highlighted by a red circle.
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Standard Operating Procedure (SOP) 4—Downloading Data Loggers
Overview
This SOP describes how to download a data logger in the field using a waterproof shuttle. This SOP also covers replacing a
missing data logger and removing a data logger at the conclusion of monitoring.

Supplies for Download of Data Logger
• Computer with HOBOware Pro software installed
• Onset HOBO Waterproof Shuttle
• USB interface cable
• Onset Optic USB Base Station (for stopping the data logger in the office after removal)
• COUPLER2-A (for Pendant), COUPLER2-C (for U22), or COUPLER2-D (for TidbiT)
• GPS (pre-loaded with site Latitude/Longitude or UTM coordinates)
• Maps
• Stream Temperature Data Logger Download Form (see example in appendix 1)
• Pencil
• Digital camera
• Digital thermometer
• Wire cutters
• 8-in. cable/zip ties (0.095 in. width; minimum two per Pendant )
• 11-in. cable/zip ties (0.18 in. width; minimum two per U22 or TidbiT)
• Flagging (optional)
• Waders/wading boots or wet wading gear

Supplies if Data Logger is Missing
• All of the supplies listed in supplies for download of data logger
• Stream Temperature Data Logger Installation Form (see example in appendix 1)
• Onset data loggers (U22, Pendant, or TidbiT)
• PVC solar shields (one per data logger)
• 36-in. cable/zip ties (0.35 in. width; three per site)
• UV resistant sandbags (two per site)
• 36-in. rebar (0.5 in. diameter; one per site)
• Rebar caps (one per piece of rebar)
• DUCKBILL Earth Anchors Model 40 (one per site)
• DUCKBILL driving rod for Model 40 (one per site)
• DUCKBILL Earth Anchors Model 68 (one per site)
• DUCKBILL driving rod for Model 68 (one per site)
• 5-lb sledge hammer
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Procedure—Prepare the Onset HOBO
Waterproof Shuttle (completed in office)
Loosen the center cap to open Onset HOBO
Waterproof Shuttle (fig. 4.1).

1.

a.

If necessary, use pliers to gently loosen the
center cap.

2.

Open HOBOware Pro software and download all
the available updates, if prompted.

3.

Connect the Onset HOBO Waterproof Shuttle to the
computer using the USB interface cable.
a.

Wait for the shuttle to be detected by the
computer.

On the HOBOware Pro main screen, click
Device > Manage Shuttle… (fig. 4.2), to open the
Waterproof Shuttle Management dialog box.

4.

Figure 4.1. Photograph showing Onset HOBO Waterproof Shuttle
with center cap open.

Figure 4.2. Screen capture showing HOBOware Pro Manage Shuttle… option under the Device menu.
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5.

Check battery level in Waterproof Shuttle
Management… dialog box (fig. 4.3). If the battery
voltage level is low (≤2.2 V), replace the shuttle
batteries, otherwise continue with step 6.

c.

Push down on the large cap and turn counterclockwise to remove (fig. 4.5).

d.

Gently remove the circuit board from the plastic
shuttle housing (fig. 4.6).

a.

Disconnect the shuttle from computer (the center cap
should already be open).

e.

b.

Pull the rubber loop free of the large cap. The large
cap cannot be unscrewed with the rubber loop in
place (fig. 4.4).

Remove the two AA batteries and replace with new
batteries in the correct orientation (that is, positive
end facing the USB port on the circuit board).

f.

Slide the circuit board back into the shuttle housing,
carefully aligning it with the slots in the housing
(fig. 4.7).

Figure 4.3. Screen capture showing HOBOware Pro Waterproof Shuttle Management dialog box. The red oval highlights the
battery voltage.

Figure 4.4. Photograph showing Onset HOBO Waterproof Shuttle
with center cap and rubber loop removed.

Figure 4.5. Photograph showing Onset HOBO Waterproof Shuttle
with large cap removed.
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g.

When the circuit board is reinstalled correctly, the
USB port should face the open end and the LEDs
should be visible through the opening on the label
(fig. 4.8).

h.

Line up the tabs on the large cap with the slots on
the shuttle housing, press down gently, and turn
clockwise until the large cap is completely closed.

i.

Replace the rubber loop between the shuttle housing
and the large cap.

j.

Re-connect the Onset HOBO Waterproof Shuttle
to the computer using the USB interface cable and
confirm the battery voltage is ≥2.2 V (see steps 4-5).

Figure 4.6. Photograph showing Onset HOBO Waterproof Shuttle
with circuit board removed.

Figure 4.7. Photograph showing close-up of Onset HOBO
Waterproof Shuttle with circuit board aligned with shuttle
housing slots.

Figure 4.8. Photograph showing Onset HOBO Waterproof
Shuttle with circuit board reinstalled correctly. Note the
USB port facing the open end and the LEDs are visible
through the opening on the label.
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6.

7.

Launch the shuttle to synchronize its clock with the
computer’s clock and prepare to download data loggers.
a.

Click the Launch Shuttle button in lower right
corner of the Waterproof Shuttle Management
dialog box.

b.

Click Yes when prompted to launch the shuttle. The
text “Shuttle Launched Successfully” will display in
Files on Shuttle field (fig. 4.9).

Disconnect the Onset HOBO Waterproof Shuttle from
the computer and replace the center cap (hand tighten;
do not use pliers or other tools).

Procedure—Locate Site
1.

Create the Download Form prior to entering the field
using pictures/descriptions taken during data logger
installation (see SOP 3–Installing Data Loggers in a
Stream).

2.

Navigate to the site using a GPS unit, maps, and the
Stream Temperature Data Logger Download Form (see
example in appendix 1).

Figure 4.9. Screen capture showing HOBOware Pro Waterproof Shuttle Management dialog box. Note that the shuttle has been
launched successfully.
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Procedure—Download Data Logger
1.

Remove the temperature data logger from anchor by
cutting the cable/zip ties with wire cutters.

2.

Slide the data logger out of the PVC solar shield and
discard the cable/zip ties.

3.

Remove any sediment or algae from the optic
communications window on the data logger (fig. 4.10).

4.

Connect the data logger to the Onset HOBO Waterproof
Shuttle by using the appropriate coupler.

5.

Press the coupler lever. The yellow Transfer light will
flash (fig. 4.11).

6.

a.

Do not remove the data logger when the yellow
Transfer light is flashing.

b.

When the data is finished downloading the green OK
light will flash (fig. 4.12).

If the red Fail light flashes during the download
(fig. 4.13), remove the data logger from the coupler and
make sure the communications window is clean, then
re-insert the data logger and press the coupler lever.
a.

If the red Fail light continues to flash, remove the
malfunctioning data logger from the site and replace
with a new data logger. Contact the manufacturer
to arrange data extraction and servicing of the
malfunctioning data logger. Use methods outlined
in SOP 3—Installing Data Loggers in a Stream
to install the new data logger. Use a Stream
Temperature Data Logger Installation Form to record
data on the new installation.

Figure 4.10. Photographs showing Onset U22 data logger with
(A) a dirty and (B) a clean optic communications window.

Figure 4.11. Photograph showing Onset HOBO
Waterproof Shuttle with coupler pressed and a lit
yellow Transfer light. A flashing Transfer light indicates
that data is in the process of being transferred from a
data logger to the shuttle.

Figure 4.12. Photograph showing Onset HOBO
Waterproof Shuttle with a lit green OK light. A flashing
OK light indicates that data transfer process from data
logger to shuttle is complete.
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Procedure—Record Data on Stream
Temperature Data Logger Download Form

Figure 4.13. Photograph showing Onset HOBO
Waterproof Shuttle with a lit red Fail light. A flashing
Fail light indicates that data transfer process from
data logger to shuttle has failed.

7.

When the green OK light flashes, remove the data logger
from the coupler. The shuttle will automatically relaunch
the logger with its previous launch settings.

8.

After the data logger is removed from the coupler and
shuttle, press the coupler lever to stop the flashing green
OK light, or wait several minutes for OK light to stop
flashing on its own.

9.

Crew: Enter names of personnel involved with
download.

2.

Date: Enter date of download

3.

Time: Enter time of download.

4.

Site Condition: Circle Wet or Dry, depending on whether
there is water present at the site.

5.

Water Temperature: Enter temperature, measured with
digital thermometer, at time of installation.

6.

Found Data Logger?: Circle Yes or No, for whether or
not the data logger was located.

If the original anchor is failing to provide adequate
security, depth, or mixing, move the data logger to
a new location. Use methods outlined in SOP 3—
Installing Data Loggers in a Stream to install
the data logger in new location. Use a Stream
Temperature Data Logger Installation Form to record
data on the new installation.

An Onset HOBO Waterproof Shuttle can store 63 data
files. It is recommended that all files be offloaded and the
shuttle launched once per day (see SOP 5—Offloading
and Exporting in HOBOware Pro).

a.

If Yes, continue working down the Download Form.

b.

If No, make notes about what was found (for
example, anchor but no logger) and install a new
data logger using a Stream Temperature Data Logger
Installation Form. The Site # will remain the same.
Consider using a different anchor method if it was
the anchor that failed.

7.

Logger Condition at Arrival: Circle the description
that best matches the data logger’s condition at time of
download. Take care to observe the data logger condition
before removing it from the anchor.

8.

Successful Download?: Circle Yes or No, whether the
data logger was successfully downloaded.

Reattach the data logger to anchor using two new
cable/ zip ties.
a.

10.

1.

9.

a.

A successful download is indicated by a flashing
green OK light on the Onset HOBO Waterproof
Shuttle.

b.

An unsuccessful download is indicated by a flashing
red Fail light on the Onset HOBO Waterproof
Shuttle.

Action Following Download: Circle Reinstall or
Remove, for whether the data logger was reinstalled or
removed following its download.
a.

A data logger should be removed if it failed to
download properly or because the monitoring is
finished.

10.

Logger Condition at Departure: Circle the description
that best matches the data logger condition at time of
departure.

11.

Camera ID: Enter the unique identifier of the camera
used to take the site photographs, if more than one
camera is being used to photograph data logger
downloads.
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12.

Photo #’s: Enter the camera photograph file numbers
of every photograph taken at the site.

13.

Notes: Enter an update on the site and data logger
location.

Procedure—Stop a Data Logger Following
Monitoring

2.

3.

If the data logger is removed because monitoring
is finished (step 9a, Procedure—Record Data on Stream
Temperature Data Logger Download Form), recording must be
stopped using a computer.
1.

Connect the Onset Optic USB Base Station to the
computer using the USB cable and connect the
temperature data logger to the base station using the
appropriate coupler.

4.

Stop the logger from recording data.
a.

On the HOBOware Pro main screen, click Device >
Stop (fig. 4.14)

b.

Click Yes to stop the data logger recording (fig. 4.15)

c.

Click Ok to exit the dialog box indicating the data
logger has been stopped.

Verify that the logger has been stopped.
a.

On the HOBOware Pro main screen, click Device >
Status (fig. 4.16)

b.

On the Status dialog box in the Device Details
group box, the Current Status field should read:
“Logger is stopped” (fig. 4.17).

Disconnect the data logger from the base station. The
data logger is now stopped and will remain in that state
until launched again (SOP 1—Launching Data Loggers).

Figure 4.14. Screen capture showing HOBOware Pro Stop… option under the Device menu.

Figure 4.15. Screen capture showing HOBOware Pro
Stop Warning dialog box.
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Figure 4.16. Screen capture showing HOBOware Pro Status… option under the Device menu.

Figure 4.17. Screen capture showing HOBOware Pro Status dialog box. In the Device Details
group box, note that the Current Status field shows: “Logger is stopped.”
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Standard Operating Procedure (SOP) 5—Offloading and Exporting Data in
Hoboware Pro
Overview
This SOP describes how to offload data from a waterproof shuttle and export those data from HOBOware Pro software.

Supplies
• Computer with HOBOware Pro software installed
• Onset HOBO Waterproof Shuttle
• USB interface cable

Procedure—Offload Data from Waterproof
Shuttle
1.

Remove the center cap on the Onset HOBO Waterproof
Shuttle (fig. 5.1).
a.

If necessary, use pliers to gently loosen the center
cap.

2.

Open HOBOware Pro software and download all the
available updates, if prompted.

3.

Connect the Onset HOBO Waterproof Shuttle to the
computer using the USB interface cable.
a.

4.

On the HOBOware Pro main screen, click Device >
Manage Shuttle… (fig. 5.2), to open the Waterproof
Shuttle Management dialog box.
a.

5.

6.

Figure 5.1. Photograph showing Onset HOBO Waterproof Shuttle
with center cap open.

Wait a few seconds for the shuttle to be detected by
the computer.

All the files from the data loggers that were
downloaded will display with “NOT OFFLOADED”
status.

Offload all files.
a.

Make sure boxes for all files are checked.

b.

Click the Offload Checked button in lower right
corner of the dialog box (fig. 5.3).

Choose a folder to save the files (figs. 5.4 and 5.5).
a.

Click Choose… to open dialog box for selecting a
folder where the files will be saved.

b.

Do not change the Datafile Name. The name should
be the data logger’s serial number with a “.hobo”
extension.
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Figure 5.2. Screen capture showing HOBOware Pro Manage Shuttle… option under the Device menu.

Figure 5.3. Screen capture showing HOBOware Pro Waterproof Shuttle Management dialog box with three files that have not
been offloaded.
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Figure 5.4. Screen capture showing HOBOware Pro Waterproof Shuttle Management dialog box showing that three files have
been offloaded but still need to be saved to a folder on a computer.

Figure 5.5. Screen capture showing HOBOware Pro Shuttle Files Location dialog box for
selecting the folder where to save files.
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7.

Save all files.

8.

Launch the shuttle to prepare for another round of data
logger downloads.

Click the Save Checked button in lower right corner
of the Waterproof Shuttle Management dialog box
(fig. 5.6).

a.

b.

After all files have been offloaded and saved, their
Status will be “OFFLOADED” in the Waterproof
Shuttle Management dialog box (fig. 5.7).

Click the Launch Shuttle button in lower right
corner of the Waterproof Shuttle Management
dialog box.

b.

Click Yes to launch the shuttle.

Open Windows Explorer to double-check that all the
.hobo files have been saved to the folder (fig. 5.8).

c.

c.

The text “Shuttle Launched Successfully” will
display in Files on Shuttle group box (fig. 5.9).

a.

9.

Disconnect the Onset HOBO Waterproof Shuttle from
the computer and replace the center cap (hand tighten,
do not use pliers or others tools to tighten center cap).

Figure 5.6. Screen capture showing HOBOware Pro Waterproof Shuttle Management dialog box after the folder where to save
the files was changed.
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Figure 5.7. Screen capture showing HOBOware Pro Waterproof Shuttle Management dialog box after all files were properly offloaded
and saved. Note their status has changed from “NOT OFFLOADED” to “OFFLOADED”.

Figure 5.8.

Screen capture showing folder where offloaded .hobo shuttle files are saved.

44   Monitoring Stream Temperatures—A Guide for Non-Specialists

Figure 5.9. Screen capture showing HOBOware Pro screen Waterproof Shuttle Management dialog box after launching a
shuttle. Launching a shuttle erases all shuttle files and synchronizes the shuttle clock with the computer clock.

Procedure – Export Data from HOBOware Pro

3.

Browse to the folder where the .hobo files were saved
and select all the files. Click Continue (fig. 5.11).

1.

Open HOBOware Pro software and download all the
available updates, if prompted.

4.

2.

Export .hobo files as .csv files

In the Choose Export Folder dialog box, choose folder
where to save the .csv files. Browse back to the folder
with the .hobo files and click Export (fig. 5.12).

5.

When the Bulk File Export is complete, click OK
(fig. 5.13).

a.

Click Tools > Bulk File Export > Select Files to
Export… (fig. 5.10)
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Figure 5.10. Screen capture showing HOBOware Pro Select Files to Export… option under the Bulk File Export option, under
the Tools menu.

Figure 5.11. Screen capture showing HOBOware Pro Select Files to Export dialog box to select
.hobo files to export as .csv files.
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Figure 5.12. Screen capture showing HOBOware Pro Choose Export Folder dialog box to
choose the folder where .csv files will be exported.

Figure 5.13. Screen capture showing HOBOware
Pro Bulk File Export dialog box.
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Standard Operating Procedure (SOP) 6—Importing and Managing Data
Overview
This SOP describes a procedure to enter data logger data into a database. Temperature data loggers generate a large amount
of data that need to be stored and managed. The data will be more easily accessed and analyzed if the data management system
is planned and implemented with care. We recommend either using an off-the-shelf water data software application to manage
the data or developing a custom relational database in, for example, Microsoft Access, Oracle, Microsoft SQL Server, or another
application. Storing .csv files in folders and working with them individually in Microsoft Excel, for example, is not ideal.
The example used in this SOP demonstrates how to add data to AQUARIUS Time-Series software. This software is being
used extensively by the National Park Service (NPS) and U.S. Geological Survey (USGS). Specifically, the procedures shown
here outline how to use the software on the NPS server. Non-NPS users must have their own access to AQUARIUS or develop
their own database or data management system. Many of the same principles will apply, but the specific steps will be different.

Supplies
• Computer with AQUARIUS Assistant remote desktop connection file installed
• Contact the AQUARIUS System Administrator in the NPS Water Resources Division to obtain the remote desktop
connection file and access the online AQUARIUS NPS server.

Procedure—Enter Site Location Data into
AQUARIUS Springboard
1.

Start AQUARIUS software remotely, from the NPS
Natural Resource Stewardship and Science Directorate
(NRSS) server.
a.

Double-click on the AQUARIUS Assistant
(AQAssistant.rdp, fig. 6.1) remote desktop
connection file. (Make a desktop shortcut of the
file, or otherwise put the file in an easily-accessible
location.)

b.

If the RemoteApp dialog box appears (fig. 6.2),
click Connect to launch the log-in window.

c.

Enter credentials, PIN and Username hint, if
applicable, on the Windows Security log-in screen
(fig. 6.3).

d.

Click OK at the “WARNING TO USERS…”
message window (fig. 6.4).

Figure 6.2. Screen capture showing RemoteApp
connection dialog box.

Figure 6.1. AQUARIUS Assistant desktop
connection file shortcut icon.
Figure 6.3. Screen capture showing remote desktop Windows
Security dialog box. Enter log-in credentials in circled section.
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Figure 6.4. Screen capture showing “WARNING TO USERS…” security screening dialog box.

e.

On the taskbar, at the bottom right of the screen near
the date/time information, locate the AQUARIUS
Assistant mini-icon (fig. 6.5) or look in the taskbar
pop-up tray just to the left of the date/time (fig. 6.6)

f.

Right-click on AQUARIUS Assistant mini-icon and
select Launch Springboard from the pop-up menu.

g.

In the Launch AQUARIUS Springboard dialog
box, select localhost in the Server: drop-down list,
then click OK (fig. 6.7).

h.

In the AQUARIUS Server Login dialog box, enter
Active Directory Username and Password, then
click login (fig. 6.8).

2.

Create a new project in Springboard.
a.

Create a new project folder for each separate park
or monument in the relevant top-level folder (such
as the “Klamath Network” folder in a NPS example;
fig. 6.9).

b.

Right-click on the “Klamath Network” folder and
select New Project (fig. 6.10).

c.

Rename the New Folder with the four-character
code for the park or monument.
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Figure 6.5. Screen capture showing AQUARIUS Assistant mini-icon on the taskbar.

Figure 6.6. Screen capture showing AQUARIUS Assistant mini-icon in the taskbar pop-up tray.
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Figure 6.7. Screen capture showing Launch AQUARIUS Springboard dialog box.

Figure 6.8. Screen capture showing AQUARIUS Server Login dialog box.
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Figure 6.9. Screen capture showing AQUARIUS Springboard, with “Klamath Network” folder indicated.

3.

Create a new location within the new project.
a.

In the navigation panel, select the new project folder,
under “Klamath Network,” then right-click and
select New Location from the pop-up menu, or click
the Location Manager icon in the top ribbon panel
(fig. 6.11), to open the Location Manager screen.

b.

In the General tab, enter location metadata
(fig. 6.12).
i.

Enter a unique alphanumeric name in the
Identifier field; for the NPS, enter the fourcharacter park/monument code followed by
an underscore and something that represents
the site, for example, “ORCA_TM_01.” If
transferring data from the Stream Temperature
Data Logger Installation Form (appendix 1),
enter “Site #” following the park/monument
code and underscore.

ii.

Enter a location name in the Name field. The
name should be as concise and descriptive as
possible, including the waterbody name and
something about the location, for example,
“Snake Creek at Rt. 27 Bridge.”

Figure 6.10. Screen capture showing
AQUARIUS Springboard Location Folders
section showing the New Project option
under the “Klamath Network” folder.
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Figure 6.11. Screen capture showing AQUARIUS Springboard, with Location Manager icon indicated.

Figure 6.12. Screen capture showing AQUARIUS Springboard Location Manager, General tab.

iii.

Select the correct location type from the Type
drop-down list. This will depend on what type
of sampling site it is. Most stream temperature
data logger sites are going to be River/Stream.

iv.

In the Description field, provide a description
of the site so personnel unfamiliar with the site
can easily access and locate it. If transferring
data from the Stream Temperature Data Logger
Installation Form (appendix 1), enter “Notes”
here. This field is optional.

v.

In the Position field, enter latitude and longitude
values for the site, if available. Use negative
values for the longitude to indicate Western

Hemisphere. Latitude and longitude coordinates
are required to use the map-based interface.
If coordinates are entered, an elevation must
also be entered. Enter -9999 as a placeholder if
correct elevation is unknown.
vi.

Ensure the time zone indicated in the Time
Zone field is correct for the data logger. It
will become the default time zone for datasets
created at this location. This may not be the
same as the present time zone of the office
location. Using standard time throughout the
year is recommended to avoid correcting for
daylight saving time.

Standard Operating Procedure (SOP) 6—Importing and Managing Data   53

c.

d.

vii.

Select the park name from the Park Name
drop-down list.

viii.

From the Sensitivity drop-down list, select
NPS Only unless the data are to be made
available to the public. If there is a reason to
keep the data private from any other users,
including the NPS, select Restricted.

ix.

Select the best indicator of the present site
status from the Status drop-down list: Active,
Inactive, or Retired.

x.

Check the Make Location Visible in Aquarius
WebPortal box in order for the location and
its time series to be visible to the public in the
AQUARIUS WebPortal.

xi.

Remember to save frequently when adding data
or making edits by clicking on the Save miniicon or the File menu-Save option.

Add photos of the location, to aid in revisiting the
site.
i.

Click on the folder named <Identifier> in the
lower left section of the screen (fig. 6.13).

ii.

Click the New Folder mini-icon above the main
folder to create a new folder, then rename the
new folder, “Site Photos.”

iii.

Select Site Photos and click the New File miniicon (fig. 6.14).

iv.

Select a photo to be added and click Open.

v.

Select the photo to be displayed and click the
Set Location Photo mini-icon to display it on
the General tab in Location Manager.

Figure 6.13. Screen capture showing AQUARIUS
Springboard Location Manager, General tab. Arrow and
circle indicate New Folder mini-icon.

Hard-copy field notes, such as the Stream
Temperature Data Logger Installation Form,
quality control documents, or other pertinent site
information, can also be scanned and added in this
section.
i.

Click on the folder named <Identifier> (for
example, “ORCA_TM_01”) in the lower left
section of the screen (fig. 6.13).

ii.

Click the New Folder mini-icon above the main
folder, then rename the new folder, “Field Visit
Forms”.

iii.

Select the Field Visit Forms folder and click
the New File mini-icon (fig. 6.14).

iv.

Select the scanned file to be added, and click
Open.

Figure 6.14. Screen capture showing AQUARIUS
Springboard Location Manager, General tab. Arrow and
circle indicate New File mini-icon.

e.

To add additional location-based remarks or analysis
for a particular visit, go to the Analysis & Remarks
tab and click the green “plus” sign on the upper
right. Enter the date and time applicable to the
remarks, the type, and the subject. Enter remarks in
the section in the lower half of the screen (fig. 6.15),
then save by clicking on the Save mini-icon or the
File menu-Save option.
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Figure 6.15. Screen capture showing AQUARIUS Springboard Location Manager, Analysis & Remarks tab. The green
“+”, indicated by arrow, is used to add location remarks.

Procedure—Enter Temperature Data into
AQUARIUS Springboard
1.

ii.

Add Data Sets for importing data.
a.

If not already in Location Manager, open Location
Manager for the site being worked on.
i.

Select the location in AQUARIUS Springboard,
and then click on the Location Manager icon.

e.

If setting up a site that will have multiple
redundant data loggers, consider selecting Time
Series – Composite. This option allows the
user to identify which source data logger to use
as the “data feed,” and change this source over
time, if desired.

In the new Time Series, enter Data Set Details as
required (fig. 6.17).
i.

Enter “logger” in the Label field.

b.

Click on the Data Sets tab.

ii.

c.

Click the New drop-down list, and select the Time
Series option to be added (fig. 6.16).

Enter “Water Temperature” in the Description
field.

iii.

In the Comment field, enter the ID of the data
logger collecting the data in the related time
series. Add the start and end date/time for each
data logger in this time series, in case multiple
loggers are used at the site. (AQUARIUS is not
set up to track individual data loggers well. It is
set up as a site-based database.)

d.

For temperature data logger data, select Time
Series – Basic.
i.

If entering manually collected data from a site
visit, select Time Series – Field Visit.
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Figure 6.16. Screen capture showing AQUARIUS Springboard Location
Manager, Data Sets tab, showing the Time Series options under the New
drop-down menu.

Figure 6.17. Screen capture showing AQUARIUS Springboard Location Manager, Data Sets tab, showing the Data Set Details of
a new time series.
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iv.

Click Yes in the Publish field for the dataset to
be available to the public on the AQUARIUS
WebPortal; click No otherwise.

v.

vi.

2.

a.

In the Time Zone field, select the time zone that
corresponds to the data logger. This defaults to
the location’s time zone setting when creating
a new dataset. The time series time zone must
match the time zone of the imported file or
AQUARIUS will convert the incoming data to
match the time series time zone.

Prior to importing data into AQUARIUS, examine
the .csv data to make sure they conform to the
example described in step 2.f. below. Be sure to
adjust the append process based on the data as it
actually is. At a minimum, the data should have the
date/time and temperature.

b.

Select the location to which the data will be
imported.

c.

Set the Gap Tolerance 1 minute higher than the
interval by which the data logger is collecting
data. For example, if data logger is set to collect
hourly data, enter “61” for the Gap Tolerance.

Click on the Append to Logger icon in the main
Springboard window (fig. 6.18) to open the Append
Logger File tool in a new window.

d.

Click on the “Picker” widget (three dots) to the
right of Logger File: field and select a file to import
(fig. 6.19).

f.

Repeat steps 1.c.–1.e. to add another Time Series –
Basic for Voltage.

e.

g.

Click the Save & Exit mini-icon to save edits and
exit out of Location Manager.

Click on the View Logger File button to preview the
file in Excel.

f.

Click the Config Settings… button to open the
Import from File wizard.

Add .csv data to the Water Temperature Data Set.

i.

Step 1 of 4: Select Text File (CSV, etc.) from
the Time Series drop-down list, then click
Next>> (fig. 6.20).

Figure 6.18. Screen capture showing AQUARIUS Springboard, with “Append to Logger” icon indicated.
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Figure 6.19. Screen capture showing Append Logger File dialog box, with “Picker” widget circled.

Figure 6.20. Screen capture showing Import from File Wizard dialog box, Step 1 of 4.
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ii.

Step 2 of 4: Enter the following values in the
table (fig. 6.21):
• Start import at row: 3
• Number of headers: 2
• Delimiters: Comma
• Click Next>>

iii.

Step 3 of 4: Select the following formats
(fig. 6.22):
• Column 1: Select the Do not import column
(skip) button, then click the blue right arrow
to proceed to the next column.
• Column 2: Select the Date/Time button; select
mm/dd/yy HH:MM:SS PM from the Date/
Time Format drop-down list; select the
correct time zone from the Time Zone field.

• Be sure the file time zone is the same as the
time series dataset’s defined time zone or
AQUARIUS will convert the incoming file
data into the time series dataset’s defined time
zone, which may result in incorrect times.
• Column 3: Select the Data button, and the Raw
option in the drop-down list; Parameter:
Water Temp; Units: °C; Gap Tolerance: 61
(one larger than the measurement interval);
Label: Water Temp; Int. Type: 1 – Inst.
Values; Grade and Approval: <unspecified>
• Column 4: Select the Data button, and the Raw
option in the drop-down list; Parameter:
Voltage; Units: V; Gap Tolerance: 61 (one
larger than the measurement interval); Label:
Voltage; Int. Type: 1 – Inst. Values; Grade
and Approval: <unspecified>

Figure 6.21. Screen capture showing Import from File Wizard dialog box, Step 2 of 4.

Standard Operating Procedure (SOP) 6—Importing and Managing Data   59

Figure 6.22. Screen capture showing Import from File Wizard dialog box, Step 3 of 4.

points if there were redundant data, out of order data,
or other problems with the file.

• Columns 5-8: Select the Do not import
column (skip) button
• Click Next>>
iv.

Step 4 of 4: Select Apply Gap Processing
Tolerance.
• Save Configuration file to a location and name
of one’s choosing.
• Click Finish

g.

In the Append Logger File dialog box, select the
corresponding data sets into which to append the
parameter data.

h.

Click the Append button. Confirm that AQUARIUS
appended the same number of points to each time
series as was expected. There may be more points
if AQUARIUS found gaps (more than 60 minutes
between repeat measurements); there may be fewer

i.

Optional: Click Create Hot Folder to set up a
streamlined way to add future data to these data sets.
See the AQUARIUS documentation for more details.

j.

Note: AQUARIUS will not overwrite or delete data,
but it is possible to Undo an Append operation.

k.

Close the Append Logger File dialog box by
clicking the X in the upper-right.

l.

If all of the datasets for a location are not visible,
click the right-pointing blue and white arrow to
move from the location to its datasets. If already in
the dataset view, click the refresh icon to requery the
database in order to see newly-added datasets.

m.

Double-click any dataset to view it in Quick View.
One can also select a dataset and right-click on it and
choose Quick View or click the Quick View icon.
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Procedure—Enter Field Visit Information into
AQUARIUS
1.

Select the Field Visit icon at the top of the main
Springboard window (fig. 6.23) to open the Field Visit
Tool and enter information about or data from field
visits.

Installation Form (appendix 1): Site Condition,
Logger Condition, Bank, Anchor, Flagging, and
Quality.
e.

Alternatively, add a scanned copy of the Stream
Temperature Data Logger Installation Form or
other field data forms to the Hydrometric Field
Notes folder. (If the form has already been saved
in the General tab of the Location Manager, do
not save again here.) Select the Hydrometric Field
Notes folder and click the green plus sign to add an
attachment.

a.

Click the New drop-down list at the top left corner
of the window. Select Field Visit, unless a file
already exists with the relevant information in one of
the available formats (fig. 6.24).

b.

Enter the date and time of the field visit in the dialog
box and click Ok.

f.

To add a field measurement, click the New button
and select Measurement Activity.

c.

Enter the names of personnel on the work team
in Party (“Crew” from the Stream Temperature
Data Logger Installation Form; see appendix 1 for
example).

g.

Provide a Measurement ID. Enter sequentially
starting with 1 unless another ID system is being
followed. Set Conditions to Control Clear and the
Approval Level to Working (fig. 6.25)

d.

In the Remarks section, enter the following
data from the Stream Temperature Data Logger

Figure 6.23. Screen capture showing AQUARIUS Springboard, with “Field Visit” icon indicated.
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Figure 6.24. Screen capture showing Field Visit Tool, with the Field Visit option selected under the
New menu.

Figure 6.25. Screen capture showing Field Visit Tool, Measurement Activity screen.
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h.

Click the green plus sign to Add an observation
result for as many values as are going to be entered.
In this example, click once.

i.

In the Parameter field, click the magnifying
glass and select Water Temp in the New Discrete
Measurement dialog box (figs. 6.26 and 6.27). (Use
the Search box to filter the options.)

j.

Enter measurement in the Value field (fig. 6.28).

k.

Click the Save Field Visit and Exit button when
finished (fig. 6.29).

2.

Note that any measurement activity saved in the Field
Visit Tool will appear in the Data Sets tab of the
Location Manager.

3.

To record when a field visit occurred, create a new visit
file without adding any data.

Figure 6.26. Screen capture showing Field Visit Tool, Measurement Activity screen. The magnifying
glass in the Parameter field is circled.

Figure 6.27. Screen capture showing New Discrete
Measurement dialog box, with Water Temp parameter
selected.
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Figure 6.28. Screen capture showing Field Visit Tool, Measurement Activity screen. The Value field is
circled.

Figure 6.29. Screen capture showing Field Visit Tool,
Measurement Activity screen. The Save Field Visit and Exit button
is circled.

Acknowledgments
We would like to thank C. Bailey, A. Berthold, N.
Chelgren, S. Clark, D. Herring, B. Sempert, and S. Starcevich,
for discussion leading to development and refinement
of lab and field techniques. We would also like to thank
K. Anlauf‑Dunn, T. Ludington, S. Muskopf, V. Ozaki, C.
Phillips, D. Tucker, and R. Weissinger, for their thorough
reviews and constructive comments. Funding for this study
was provided by the National Park Service Klamath Inventory
and Monitoring Network and the U.S. Geological Survey
National Climate Change and Wildlife Science Center.

References Cited
Arismendi. I., Johnson, S.L., Dunham, J.B., and Haggerty. R.,
2013a, Descriptors of natural thermal regimes in streams
and their responsiveness to change in the Pacific Northwest
of North America: Freshwater Biology, v. 58, p. 880–894,
doi:10.1111/fwb.12094.
Arismendi, I., Safeeq, M., Johnson, S.L., Dunham,
J.B., and Haggerty, R., 2013b, Increasing synchrony
of high temperature and low flow in western North
American streams—Double trouble for coldwater biota?:
Hydrobiologia v. 712, p. 61–70, doi:10.1007/s10750-0121327-2.

Arismendi, I., Safeeq, M., Dunham, J.B., and Johnson, S.L.,
2014, Can air temperature be used to project
influences of climate change on stream temperature?:
Environmental Research Letters, v. 9, no. 8, 084015, 12 p.
doi:10.1088/1748-9326/9/8/084015.
Beever, E.A., Hall, L.E., Varner, J., Loosen, A.E.,
Dunham, J.B., Gahl, M.K., Smith, F.A., and Lawler, J.J.,
2017, Behavioral flexibility as a mechanism for coping with
climate change: Frontiers in Ecology and the Environment,
v. 15, no. 6, p. 299–308, doi:10.1002/fee.1502.
Benjamin, J.R., Heltzel, J.M., Dunham, J.B., Heck, M., and
Banish, N., 2016, Thermal regimes, nonnative trout, and
their influences on native bull trout in the Upper Klamath
River Basin, Oregon: Transactions of the American
Fisheries Society, v. 145, no. 6, p. 1,318–1,330, doi:10.1080
/00028487.2016.1219677.
Boyd, M., and Kasper, B., 2003, Analytical methods
for dynamic open channel heat and mass transfer—
Methodology for heat source model, version 7.0: Portland,
Oregon, Oregon Department of Environmental Quality,
193 p., accessed February 5, 2018, at https://www.oregon.
gov/deq/FilterDocs/heatsourcemanual.pdf.
Caissie, D., 2006, The thermal regime of rivers: a review:
Freshwater Biology, v. 51, no. 8, p. 1,389–1,406,
doi:10.1111/j.1365-2427.2006.01597.x.

64   Monitoring Stream Temperatures—A Guide for Non-Specialists
Chandler, G.L., Wollrab, S.P., Horan, D.L., Nagel, D.E.,
Parkes, S.L., Isaak, D.J., Wenger, S.J., Peterson, E.E.,
Ver Hoef, J.M., Hostetler, S.W., Luce, C.H., Dunham, J.B.,
Kershner, J.L., and Roper, B.B., 2016, NorWeST stream
temperature data summaries for the western U.S.: Fort
Collins, Colorado, Forest Service Research Data Archive,
accessed February 5, 2018, at https://doi.org/10.2737/RDS2016-0032.
DeWeber, J.T., and Wagner, T., 2015, Predicting brook trout
occurrence in stream reaches throughout their native range
in the Eastern United States: Transactions of the American
Fisheries Society, v. 144, no. 1, p. 11–24, doi:10.1080/0002
8487.2014.963256.
Dunham, J., Rieman, B., and Chandler, G., 2003, Influences of
temperature and environmental variables on the distribution
of bull trout within streams at the southern margin of its
range: North American Journal of Fisheries Management,
v. 23, no. 3, p. 894–904, doi:10.1577/M02-028.

Falke, J.A., Dunham, J.B., Jordan, C.E., McNyset, K.M., and
Reeves, G.H., 2013, Spatial ecological processes and local
factors predict the distribution and abundance of spawning
by steelhead (Oncorhynchus mykiss) across a complex
riverscape: PLoS ONE, v. 8, no. 11, e79232, https://doi.
org/10.1371/journal.pone.0079232.
Falke, J.A., Flitcroft, R.L., Dunham, J.B., McNyset, K.M.,
Hessburg, P.F., and Reeves, G.H., 2015, Climate change and
vulnerability of bull trout (Salvelinus confluentus) in a fireprone landscape: Canadian Journal of Fisheries and Aquatic
Sciences, v. 72, p. 304–318, doi:10.1139/cjfas-2014-0098.
Fausch, K.D., Torgersen, C.E., Baxter, C.V., and Li, H.W.,
2002, Landscapes to riverscapes- bridging the gap
between research and conservation of stream fishes:
BioScience, v. 52, no. 6, p. 483–498, doi:10.1641/00063568(2002)052[0483:LTRBTG]2.0.CO;2.

Dunham, J.B., Chandler, G.L., Rieman, B.E., and Martin, D.,
2005, Measuring stream temperature with digital data
loggers—A user’s guide: U.S. Department of Agriculture,
Forest Service, Rocky Mountain Research Center General
Technical Report RMRS-GTR-150WWW, 15 p.

Fullerton, A.H., Torgersen, C.E., Lawler, J.J., Faux,
R.N., Steel E.A., Beechie, T.J., Ebersole, J.L., and
Leibowitz, S.G., 2015, Rethinking the longitudinal stream
temperature paradigm: region-wide comparison of thermal
infrared imagery reveals unexpected complexity of river
temperatures: Hydrological Processes, v. 29, no. 22,
p. 4,719–4,737, doi:10.1002/hyp.10506.

Dunham, J.B., Hockman-Wert, D., Chelgren, N., and
Heck, M., 2015, Rangewide climate vulnerability
assessment for threatened bull trout: U.S. Geological
Survey, Forest and Rangeland Ecosystem Science Center,
Final Report to Northwest Climate Science Center, 47 p.

Groom, J.D., Dent, L., Madsen, L.J., and Fleuret, J., 2011,
Response of western Oregon (USA) stream temperatures
to contemporary forest management: Forest Ecology
and Management, v. 262, p. 1,618–1,629, doi:10.1016/j.
foreco.2011.07.012.

Dunham, J.B., Rosenberger, A.E., Luce, C.H., and
Rieman, B.E., 2007, Influences of wildfire and channel
reorganization on spatial and temporal variation in stream
temperature and the distribution of fish and amphibians:
Ecosystems, v. 10, p. 335–346, doi:10.1007/s10021-0079029-8.

Heck, M.P., 2007, Effects of wildfire on growth and
demographics of coastal cutthroat trout in headwater
streams: Corvallis, Oregon, Oregon State University,
Master’s thesis, 63 p.

Eaton, J.G., McCormick, J.H., Goodno, B.E., O’Brien, D.G.,
Stefany, H.G., Hondzo, M., and Scheller, R.M., 1995,
A field information-based system for estimating fish
temperature tolerances: Fisheries, v. 20, no. 4, p. 10–18,
doi:10.1577/1548-8446(1995)020<0010:AFISFE>2.0
.CO;2.
Everall, N.C., Johnson, M.F., Wilby, R.L., and Bennett, C.J.,
2015, Detecting phenology change in the mayfly Ephemera
danica responses to spatial and temporal water temperature
variations: Ecological Entomology, v. 40, no. 2, p. 95–105,
doi:10.1111/een.12164.
Falke, J.A., Dunham, J.B., and Hockman-Wert, D., 2016, A
simple prioritization tool to diagnose impairment of stream
temperature for coldwater fishes in the Great Basin: North
American Journal of Fisheries Management, v. 36, p.
147–160, doi:10.1080/02755947.2015.1115449.

Horning, W.B., II, and Pearson, R.E., 1973, Growth
temperature requirements and lower lethal temperatures for
juvenile smallmouth bass (Micropterus dolomieui): Journal
of the Fisheries Board of Canada, v. 30, no. 8,
p. 1,226–1,230, doi:10.1139/f73-194.
Isaak, D.J., and Horan, D.L., 2011, An assessment of
underwater epoxies for permanently installing temperature
sensors in mountain streams: North American Journal of
Fisheries Management, v. 31, p. 134–137, doi:10.1080/0275
5947.2011.561172.
Isaak, D.J., Muhlfeld, C.C., Todd, A.S., Al-chokhachy, R.,
Roberts, J., Kershner, J.L., Fausch, K.D., and
Hostetler, S.W., 2012, The past as prelude to the future
for understanding 21st-century climate effects on rocky
mountain trout: Fisheries. v. 37, no. 12, p. 542–556,
doi:10.1080/03632415.2012.742808.

References Cited  65
Isaak, D.J., Peterson, E.E., Ver Hoef, J.M., Wenger, S.J.,
Falke, J.A., Torgersen, C.E., Sowder, C., Steel, E.A.,
Fortin, M.-J., Jordan, C.E., Ruesch, A.S., Som, N., and
Monestiez, P., 2014, Applications of spatial statistical
network models to stream data: WIREs Water, v. 3, no. 1,
p. 277–294, doi:10.1002/wat2.1023.
Isaak, D.J., Ver Hoef, J.M., Peterson, E.E., Horan, D.L.,
and Nagel, D.E., 2016, Scalable population estimates
using Spatial-Stream-Network (SSN) models, fish density
surveys, and national geospatial database frameworks
for streams: Canadian Journal of Fisheries and Aquatic
Sciences, v. 74, no. 2, p. 147–156, doi:10.1139/cjfas-20160247.
Isaak, D.J., Wenger, S.J., Peterson, E.E., Ver Hoef, J.M.,
Hostetler, S.W., Luce, C.H., Dunham, J.B., Kershner, J.L.,
Roper, B.B., Nagel, D.E., Chandler, G.L., Wollrab, S.P.,
Parkes, S.L., and Horan, D.L., 2016, NorWeST modeled
summer stream temperature scenarios for the western
U.S.: Fort Collins, Colorado, Forest Service Research
Data Archive, accessed February 5, 2018, at https://doi.
org/10.2737/RDS-2016-0033.
Isaak, D.J., Young, M.K., Luce, C.H., Hostetler, S.W.,
Wenger, S.J., Peterson, E.E., Ver Hoef, J.M., Groce, M.C.,
Horan, D.L., and Nagel, D.E., 2016, Slow climate velocities
of mountain streams portend their role as refugia for coldwater biodiversity: Proceedings of the National Academy
of Sciences, v. 113, no. 16, p. 4,374–4,379, doi:10.1073/
pnas.1522429113.
Johnson, S.L., and Jones, J.A., 2000, Stream temperature
responses to forest harvest and debris flows in western
Cascades, Oregon: Canadian Journal of Fisheries and
Aquatic Sciences, v. 57, p. 30–39, doi:10.1139/f00-109.
Kammerer, B.D., and Heppell, S.A., 2013, Individual
condition indicators of thermal habitat quality in field
populations of redband trout (Oncorhynchus mykiss
gairdneri): Environmental Biology of Fishes, v. 96, no. 7,
p. 823–835, doi:10.1007/s10641-012-0078-2.

Maheu, A., Poff, N.L., and St-Hilaire, A., 2015, A
classification of stream water temperature regimes in the
conterminous USA: River Research and Applications, v. 32,
no. 5, p. 896–906, doi:10.1002/rra.2906.
Mauger, S., Shaftel, R., Trammell, E.J., and Geist, M.,
2015, Regional studies stream temperature data collection
standards for Alaska—Minimum standards to generate
data useful for regional-scale analyses: Journal of
Hydrolology—Regional Studies, v. 4, part B, p. 431–438,
doi:10.1016/j.ejrh.2015.07.008.
McCullough, D.A., 2010, Are coldwater fish populations of
the United States actually being protected by temperature
standards?: Freshwater Reviews, v. 3, p. 147–199,
doi:10.1608/FRJ-3.2.4.
McNyset, K., Volk, C., and Jordan, C., 2015, Developing an
effective model for predicting spatially and temporally
continuous stream temperatures from remotely sensed land
surface temperatures: Water, v. 7, no. 12, p. 6,827–6,846,
doi:10.3390/w7126660.
Neuheimer, A.B., and Taggart, C.T., 2007, The growing
degree-day and fish size-at-age: the overlooked metric:
Canadian Journal of Fisheries and Aquatic Sciences, v. 64,
no. 2, p. 375–385, doi:10.1139/f07-003.
Nichols, J.D., and Williams, B.K., 2006, Monitoring for
conservation: Trends in Ecology & Evolution, v. 21,
p. 668–673, doi:10.1016/j.tree.2006.08.007.
Peterson, J.T., and Dunham, J.B., 2010, Chapter 3—Scale and
fisheries management, in Hubert, W., and Quist, M., eds.,
Inland Fisheries Management (3d ed.): Bethesda, Maryland,
American Fisheries Society, p. 81–105.
Poff, N.L., 1997, Landscape filters and species traits—
Towards mechanistic understanding and prediction in
stream ecology: Journal of North American Benthological
Society, v. 16, p. 391–409, doi:10.2307/1468026.

Kovach, R.P., Muhlfeld, C.C., Wade, A.A., Hand, B.K.,
Whited, D.C., DeHaan, P.W., Al-Chokhachy, R., and
Luikart, G., 2015, Genetic diversity is related to climatic
variation and vulnerability in threatened bull trout: Global
Change Biology, v. 21, no. 7, p. 2,510–2,524, doi:10.1111/
gcb.12850.

Poole, G., Dunham, J., Hicks, M., Keenan, D., Lockwood, J.,
Materna, E., McCullough, D., Mebane, C., Risley, J.,
Sauter, S., Spalding, S., and Sturdevant, D., 2001, Scientific
issues relating to temperature criteria for salmon, trout, and
charr native to the Pacific Northwest: Seattle, Washington,
U.S. Environmental Protection Agency, EPA 910-R-01-007,
24 p., accessed February 5, 2018, at https://nepis.epa.gov/
Exe/ZyPDF.cgi?Dockey=P1004J0T.PDF.

Luce, C., Staab, B., Kramer, M., Wenger, S., Isaak, D.,
and McConnell, C., 2014, Sensitivity of summer stream
temperatures to climate variability in the Pacific Northwest:
Water Resources Research, v. 50, no. 4, p. 3,428–3,443,
doi:10.1002/2013WR014329.

Poole, G.C., and Berman, C.H., 2001, An ecological
perspective on in-stream temperature—Natural heat
dynamics and mechanisms of human-caused thermal
degradation: Environmental Management, v. 27,
p. 787–802, doi:10.1007/s002670010188.

Magnuson, J.J., Crowder, L.B., and Medvick, P.A., 1979,
Temperature as an ecological resource: American Zoologist,
v. 19, p. 331–343, doi:10.1093/icb/19.1.331.

66   Monitoring Stream Temperatures—A Guide for Non-Specialists
Schultz, L., Heck, M., Hockman-Wert, D., Allai, T.,
Wenger, S., and Dunham, J., 2017, Spatial and temporal
variability in the effects of wildfire and drought on thermal
habitat for a desert trout: Journal of Arid Environments,
v. 145, p. 60–68, doi:10.1016/j.jaridenv.2017.05.008.

Torgersen, C., Ebersole, J., and Keenan, D., 2012, Primer for
identifying cold-water refuges to protect and restore thermal
diversity in riverine landscapes: Seattle, Washington, U.S.
Environmental Protection Agency, EPA scientific guidance
handbook 910-C-12-001, 78 p.

Shepard, B.B., Al-Chokhachy, R., Koel, T., Kulp, M.A.,
and Hitt, N., 2016, Likely responses of native and
invasive salmonid fishes to climate change in the Rocky
Mountains and Appalachian Mountains, in Hansen, A.J.,
Monahan, W.B., Olliff, S.T., and Theobald, B.M., eds.,
Climate change in wildlands: Washington D.C., Island
Press/Center for Resource Economics, p. 234–255,
doi:10.5822/978-1-61091-713-1_12.

U.S. Environmental Protection Agency, 2014, Best practices
for continuous monitoring of temperature and flow in
wadeable streams: Washington, D.C., National Center
for Environmental Assessment, Global Change Research
Program, EPA/600/R-13/170F, 70 p.

Som, N.A., Monestiez, P., Ver Hoef, J.M., Zimmerman, D.L.,
and Peterson, E.E., 2014, Spatial sampling on
streams—Principles for inference on aquatic networks:
Environmetrics, v. 25, p. 306–323, doi:10.1002/env.2284.
Sowder, C., and Steel, E.A., 2012, A note on the collection and
cleaning of water temperature data: Water, v. 4, p. 597–606,
doi:10.3390/w4030597.
Steel, E.A., and Lange, I.A., 2007, Using wavelet analysis to
detect changes in water temperature regimes at multiple
scales—Effects of multi-purpose dams in the Willamette
River Basin: River Research and Applications, v. 23,
p. 351–359, doi:10.1002/rra.985.
Todd, A.S., Coleman, M.A., Konowal, A.M., May, M.K.,
Johnson, S., Vieira, N.K.M., and Saunders, J.F., 2008,
Development of new water temperature criteria to
protect Colorado’s fisheries: Fisheries, v. 33, p. 433–443,
doi:10.1577/1548-8446-33.9.433.

USA National Phenology Network, 2017, USA National
Phenology Network: USA-NPN online database, accessed
February 5, 2018, at https://usanpn.org/.
Vannote, R.L., and Sweeney, B.W., 1980, Geographic analysis
of thermal equilibria—A conceptual model for evaluating
the effect of natural and modified thermal regimes on
aquatic insect communities: The American Naturalist,
v. 115, no., 5, p. 667–695, doi:10.1086/283591.
Ver Hoef, J.M., Peterson, E.E., Clifford, D., and Shah, R.,
2014, SSN—An R package for spatial statistical modeling
on stream networks: Journal of Statistical Software, v. 56,
no. 3, p. 1–45, doi:10.18637/jss.v056.i03.
Wehrly, K.E., Wang, L., and Mitro, M., 2007, Fieldbased estimates of thermal tolerance limits for trout—
Incorporating exposure time and temperature fluctuation:
Transactions of the American Fisheries Society, v. 136,
no. 2, p. 365–374, doi:10.1577/T06-163.1.
Wigington, P.J., Jr., Leibowitz, S.G., Comeleo, R.L., and
Ebersole, J.L., 2012, Oregon hydrologic landscapes—A
classification framework: Journal of the American Water
Resources Association (JAWRA), v. 49, no. 1, p. 163–182,
doi:10.1111/jawr.12009.

Appendix 1  67

Appendix 1. Data Logger Installation and Download Forms
The blank Installation and Download Forms can be used as templates or customized to meet specific project needs. The
completed Installation Form is intended to show the level of detail that should be recorded. The three completed Download
Forms are intended to show the level of detail that should be recorded when a data logger is found and downloaded, a data
logger is found but not successfully downloaded, and a data logger is not found.

Stream Temperature Data Logger Installation Form
Site #:

Crew:

Date:

Time:

Data Logger Serial #:
Latitude:

Longitude:

Site Condition:

Wet

Data Logger Condition:

Anchor:

Sandbags

Rebar

Flagging:

Yes

No

Quality:

Great

OK

Water Temperature:

Submerged

Submerged at surface

Exposed at surface

Dry

Left

Bank (looking downstream):

Camera ID:

Dry

Cable/zip ties

Middle

Right

DUCKBILL

Poor
Photo #’s:

Notes: Provide a written description or sketch of the site so it can be easily accessed and located in the future by someone
who has never been there:
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Stream Temperature Data Logger Installation Form
Site #:

USGS-25618

Crew:

Heck, Allai

Date:

08/28/15

Time:

1537

Data Logger Serial #:
Latitude:

EXAMPLE

9810433
Longitude:

42.13586

Site Condition:

Wet

Data Logger Condition:

Dry

Anchor:

Sandbags

Rebar

Flagging:

Yes

No

Quality:

Great

OK

Camera ID:

Canon D30

Water Temperature:

Submerged

Submerged at surface

Exposed at surface

Dry

Left

Bank (looking downstream):

-118.24100

Cable/zip ties

Middle

Right

DUCKBILL

Poor
Photo #’s:

1787 & 1788

Notes: Provide a written description or sketch of the site so it can be easily accessed and located in the future by someone
who has never been there:

Logger anchored to a DUCKBILL and placed ~2 m downstream of a channel-spanning willow. Upper portions of the willow
are dead, burnt branches. It is the largest willow within 100 m of the site. Logger is just upstream of two boulders that protrude
from the water at base flow. Access site from the right bank.
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Stream Temperature Data Logger Download Form
Site #:
Data Logger Serial #:
Previous Crew:
1. Locate Site
Latitude:
Bank
Site Condition:
Comments:

Pictures:

Longitude:
Anchor:

Flagging:

Quality:
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2. Download Temperature Data Logger
Site #:

Crew:

Date:

Time:

Data Logger Serial #:
Site Condition:

Wet

Dry

Found Data Logger?:

Yes

No

Logger Condition at Arrival:

Successful Download?:

Yes

Water Temperature:

Submerged

Submerged at surface

Exposed at surface

Dry

No

Action Following Download:

Reinstall

Remove

Logger Condition at Departure:

Submerged

Submerged at surface

Exposed at surface

Dry

Camera ID:
Notes:

Photo #s:
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Stream Temperature Data Logger Download Form

EXAMPLE

Site #: USGS-25618
Data Logger Serial #:
Previous Crew:

9810433

Heck, Allai

1. Locate Site
Latitude: 42.13586
Bank Left

Longitude: -118.24100
Anchor: DUCKBILL

Flagging: Yes

Quality: Great

Site Condition: Wet
Comments: Logger anchored to a DUCKBILL and placed ~2 m downstream of a channel-spanning willow. Upper portions of the
willow are dead, burnt branches. It is the largest willow within 100 m of the site. Logger is just upstream of two boulders that
protrude from the water at base flow. Access site from the right bank.
Pictures:
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EXAMPLE

2. Download Temperature Data Logger
Site #: USGS-25618
Date:

08/22/16

Crew:

Schultz, Jones

Time:

0912

Data Logger Serial #: 9810433
Site Condition:

Wet

Dry

Found Data Logger?:

Yes

No

Logger Condition at Arrival:

Successful Download?:

Yes

Action Following Download:
Logger Condition at Departure:

Water Temperature:

Submerged

Submerged at surface

Exposed at surface

Dry

No
Reinstall

Remove

Submerged

Submerged at surface

Exposed at surface
Camera ID: Canon D30

11.0°C

Dry
Photo #s: 2023 - 2026

Notes:
Logger found completely submerged. Following download, re-attached logger and PVC solar shield to DUCKBILL using new 11”
cable/zip ties. Hung new orange flagging on large willow just upstream of logger. Took new pictures.
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Stream Temperature Data Logger Download Form

EXAMPLE

Site #: USGS-25618
Data Logger Serial #:
Previous Crew:

9810433

Heck, Allai

1. Locate Site
Latitude: 42.13586
Bank Left

Longitude: -118.24100
Anchor: DUCKBILL

Flagging: Yes

Quality: Great

Site Condition: Wet
Comments: Logger anchored to a DUCKBILL and placed ~2 m downstream of a channel-spanning willow. Upper portions of the
willow are dead, burnt branches. It is the largest willow within 100 m of the site. Logger is just upstream of two boulders that
protrude from the water at base flow. Access site from the right bank.
Pictures:
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EXAMPLE

2. Download Temperature Data Logger
Site #: USGS-25618
Date:

08/22/16

Crew:

Schultz, Jones

Time:

0912

Data Logger Serial #: 9810433
Site Condition:

Wet

Dry

Found Data Logger?:

Yes

No

Logger Condition at Arrival:

Successful Download?:

Yes

Action Following Download:
Logger Condition at Departure:

Water Temperature:

Submerged

Submerged at surface

Exposed at surface

Dry

No
Reinstall

Remove

Submerged

Submerged at surface

Exposed at surface
Camera ID:

11.0°C

Dry
Photo #s:

Notes:
Data logger found completely submerged but failed to download. Re-wiped algae off the optic communications on the data
logger. The status light on the Optic Shuttle blinks yellow for several seconds but turns to red. Suspect that the data logger’s
battery is dead. Removed data logger 9810433 and installed a new data logger at the site. Will use a “Stream Temperature Data
Logger Installation Form” to document the new installation. The Site # will remain the same.

Appendix 1  75

Stream Temperature Data Logger Download Form

EXAMPLE

Site #: USGS-25618
Data Logger Serial #:
Previous Crew:

9810433

Heck, Allai

1. Locate Site
Latitude: 42.13586
Bank Left

Longitude: -118.24100
Anchor: DUCKBILL

Flagging: Yes

Quality: Great

Site Condition: Wet
Comments: Logger anchored to a DUCKBILL and placed ~2 m downstream of a channel-spanning willow. Upper portions of the
willow are dead, burnt branches. It is the largest willow within 100 m of the site. Logger is just upstream of two boulders that
protrude from the water at base flow. Access site from the right bank.
Pictures:
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EXAMPLE

2. Download Temperature Data Logger
Site #: USGS-25618
Date:

08/22/16

Crew:

Schultz, Jones

Time:

0912

Data Logger Serial #: 9810433
Site Condition:

Wet

Dry

Found Data Logger?:

Yes

No

Logger Condition at Arrival:

Successful Download?:

Yes

Action Following Download:
Logger Condition at Departure:

Water Temperature:

Submerged

Submerged at surface

Exposed at surface

Dry

No
Reinstall

Remove

Submerged

Submerged at surface

Exposed at surface
Camera ID:

11.0°C

Dry
Photo #s:

Notes:
Data logger found completely submerged but failed to download. Re-wiped algae off the optic communications on the data
logger. The status light on the Optic Shuttle blinks yellow for several seconds but turns to red. Suspect that the data logger’s
battery is dead. Removed data logger 9810433 and installed a new data logger at the site. Will use a “Stream Temperature Data
Logger Installation Form” to document the new installation. The Site # will remain the same.
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